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Editorial 
Welcome to a superbly packed issue 
of 2DArtist, and in marking the end of 
another year we’ll be checking out the 
final chapters of three of our current 
tutorial series’, in preparation for three 
brand new ones starting in January for a 
fresh and sparkly 2010! 

We’ve gone environment friendly this 
month with three tutorials dedicated to 
creating stunning environments! First 
up, Serg Souleiman is here to teach 

us his techniques when using a 3D base, created in Google SketchUp, 
to concept an industrial scene. With this series we’ve been giving artists 
free reign in terms of the genre of work they create, and it’s been a great 
experience to watch as they’ve all created and submitted such wildly 
different scenes. I think we have certainly proved a point with this series: 
that simple 3D can in fact improve your painting workflow and help you 
face some of those tricky perspective, scale and depth issues! So be 
afraid no more: 3D is your friend – embrace it!

Our second environment tutorial comes in the form of Roberto F. Castro’s 
Custom Brushes lesson, in which he shows us how to master the art of 
creating brushes to paint leaves and trees for environments (p.70). If 
you’ve ever had problems painting trees for your scenes, then you’ll want 
to check this out: Roberto takes us from scratch through the entire brush 
creation process, showing us how to create the trunk and add the different 
layers of leaves using different custom-made brushes to get a wholly 
believable-looking end result! 

And to wrap up the environment painting craze we have happily stumbled 
into this month, Nykolai Aleksander brings us the final installment of her 
Beginner’s Guide to Digital Painting tutorial series for Photoshop, where 
she’s making all those final adjustments and saving the image out for 
various needs (p.88). If you’ve been following this series then you’ll no 
doubt be a Nykolai fan by now; she has brought us honest and light-
hearted tutorials filled with information that you can only get from an 
artist who has been painting every day (sometimes without sleeping) in 
Photoshop for the past 7 years! This is someone who has very kindly and 
selflessly offered us her complete knowledge, and you’d be a fool not to 
take her advice on board. So get studying and paint, paint, paint! 

Bringing something new to the table this month is Richard Tilbury, with his 
first chapter of our new Painting the Undead series. This month: painting 
a vampire! Avoiding clichés and wanting to make his own mark on the 
subject, Richard takes us right from the thumbnailing stage and through 
the entire concepting and painting process, so get your oversized cape on 
and fly over to p.80 for your first fix of some ghoulish painting fun!

Our interviews this month feature the charismatic and openly honest artist, 
David Smit, as well as the geniuses behind the immensely successful 
– and downright fun – Flash game, Machinarium. David Smit was with 
us last month to conclude our Dynamic Characters tutorial series, and 
we had such fun working with him that we wanted to know more, and 

thought you all should, too! David is not only well traveled in a global 
sense, but has also worked for various game companies and 
has an impressive educational CV to boot. To find out why he 
seeks to do what those will not expect, and how Lego helped to 

forge his creative career, check out p.6. Jakub Dvorský & Adolf 
Lachman then talk to us on behalf of Amanita Design on about 
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the adorable and hugely addictive, Machinarium. For a behind the scenes 
look, turn to p.30.

Our Sketchbook this month has shaped up to be a deep and curious 
look into John U. Abrahamson’s sketches for his upcoming exhibition in 
California, Flesh and Blood. Using an automatic drawing process, John 
uncovers strong feelings and issues that come to light when he puts pencil 
to paper, often associated with his abandonment by his mother as a child, 
as well as past relationships and the inspirational beauty he sees when 
he’s out and about in the world. Seeing the world through another’s eyes 
can really open your own to what’s around you, so be sure to talk a walk 
today, fill your lungs with some fresh air, and breathe in some inspiration! 
We’ll be seeing you in 2010. Have a very happy Christmas and a creative 
New Year! Ed.

http://www.2dartistmag.com


Setting up your PDF reader 
For optimum viewing of the magazine it is recommended that you have 

the latest Acrobat Reader installed.  

You can download it for free here:  DOWNLOAD!   

To view the many double-page spreads featured in 2DArtist magazine, 

you can set the reader to display ‘two-up’, which will show double-

page spreads as one large landscape image: 

   

1. Open the magazine in Reader;   

2. Go to the View menu, then Page display; 

3. Select Two-up Continuous, making sure that Show Cover 
Page is also selected.

Get the most out of your 

Magazine!
If you’re having problems viewing the double-page spreads that we 

feature in this magazine, follow this handy little guide on how to set 

up your PDF reader!

http://www.adobe.com/products/acrobat/readstep2.html
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Contributing Artists
Every month many artists around the world contribute to 3DCreative and 

2DArtist magazines. Here you can find out a bit more about them! 

If you would like to be a part of 3DCreative or 2DArtist magazine, 

please contact: lynette@3dtotal.com

Nykolai  
Aleksander

Born in Germany in 1978, 

Nykolai moved to England in 

1999, and currently lives in 

South Africa with her husband. 

She’s been painting digitally since 2002, and works 

as a freelance illustrator for both private clients and 

companies.

 

 

 

www.admemento.com 

x@admemento.com

David  
Smit
When not traveling or working 

overseas, David resides in 

Amsterdam, freelancing in 

concept art, illustration and art 

direction jobs. It’s only when he sleeps that he’s not 

busy! He is always on the search for great projects, 

opportunities, stories, good music, and a nice cold 

beer. 

www.davidsmit.com 

david@davidsmit.com

John U. 
Abrahamson
Born in a suburb of Chicago 

in 1962, Abrahamson was 

introduced to religion at a 

very young age, acquiring the 

religious visual vocabulary that would later play 

so heavily in his work. He attended the School of 

the Art Institute of Chicago. His artistic inspirations 

include: his religious upbringing, his first wife’s 

physical disability, and the urban decay of Chicago’s 

neighborhoods. 

www.JohnUA.com | fleshendblood.blogspot.com

jua@johnua.com

Roberto  
F.Castro
An architect and visual artist; 

Roberto has won awards 

in architecture and design 

and is the author of several 

architectural projects. As a visual artist he uses 

both traditional and digital techniques alike, and 

he develops works incorporating digital painting, 

concept art and animation. A great part of his work 

is focused on architectural environments, futuristic 

design, and character/creature design. 

http://robertofc.com/

contact@robertofc.com

Richard
Tilbury

Has had a passion for drawing 

since being a couple of feet 

tall. He studied fine art and was 

eventually led into the realm 

of computers several years ago. His brushes have 

slowly been dissolving in white spirit since the late 

90s, and now his graphics tablet has become their 

successor. He still sketches regularly, balancing his 

time between 2D and 3D. 

 

www.richardtilburyart.com 

rich@3dtotal.com

http://www.2dartistmag.com
mailto:lynette@3dtotal.com
http://www.admemento.com
mailto:x@admemento.com
http://www.davidsmit.com
mailto:david@davidsmit.com
http://www.JohnUA.com
http://fleshendblood.blogspot.com
mailto:jua@johnua.com
http://robertofc.com/
mailto:contact@robertofc.com
http://www.richardtilburyart.com
mailto:rich@3dtotal.com
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Amanita  

Design 
A small independent game 

developing studio established 

in 2003, located in the Czech 

Republic. Amongst their 

most popular projects are the games, Samorost1, 

Samorost2, Questionaut and Machinarium.

  

www.amanita-design.net

contact@amanitadesign.com

Branko  
Bistrovic
Color Supervisor in an 

animation studio by day, and 

a dark and handsome doodler 

by night. He hopes to one day 

achieve the coveted status of concept artist, but for 

the moment is happy with bringing to life his own 

imaginings for himself, as well as some contract work 

on the side, of course.  

 

 

http://branko.cgsociety.org/gallery/

bisvic@gmail.com

http://www.2dartistmag.com
http://www.3dcreativemag.com
http://www.amanita-design.net
mailto:contact@amanitadesign.com
http://branko.cgsociety.org/gallery
mailto:bisvic@gmail.com


David Smit, 12 months into his travels around the world whilst freelancing and working as an art director to 

fund his way, gives us a few moments from his enviable life in our latest 2DArtist interview. He tells us a bit 

about his childhood inspiration, his journey through and experience at various games companies, and also 

shares with us some of his loves and hates when it comes to community challenges. This is a frank and 

honest interview with an artist who knows his mind and seeks to do what people won’t expect of him. So 

join us for some laughs, some serious bits, and above all a stunning portfolio. Enjoy!

“I still want everything, to do 
everything, see everything, and make 
everything... my goal now is to keep 
working at the places where work is 
not a job, but a passion.”
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I walked in a very green wannabe artist and 

walked out… well, still quite green, but at least 

with the confidence that I had made it to the 

paying-drawing-pictures group. I crossed the 

barrier... which is a bit weird when I think back 

to it; I always had this uncertain “am I ever 

going to be good enough to get paid?” feeling, 

and before I knew it there was no escaping the 

industry. So that’s where it started. Not a bad 

place, in my opinion. It’s for that reason that I 

Interview with David Smit 

Hi David, and welcome back to 2DArtist for our 

48th issue interview – that’s four years’ worth 

of interviews, would you believe? Where do we 

find you all, hey? [Winks]. So let’s get down to 

some of that Q&A good stuff! Can you kick us 

off with a bit of background info about yourself?

Four years and this is the first time you 

interview me? What took you so long! [Winks]. 

Hey, the usual boring who am I and where do 

I come from stuff? It’s probably easier to read 

my resume [Laughs]. No, but really, isn’t this 

interview to get more background info about 

me? It would make the whole thing quite short if 

I just tell you everything here! 

[Laughs] Well, when you put it like that! OK, let 

me be more specific then: You’ve been working 

as a concept artist since 2006 for various 

companies, as well as freelancing, so can you 

tell us a little about your experience working in 

the games industry over the last three years? 

How have things changed since you first started 

out? (For those who want to check out the 

resume, go to: www.davidsmit.com/cv.html)

OK, well it all started a long, long time ago in 

a place far, far from here ... at my internship at 

W!Games, Amsterdam. That was the first time 

I actually had a job in the games industry – at 

least the first time in the serious, paying games 

industry and not one of those everlasting never-

really-getting-anywhere-in-the-next-30-years-

but-you’ll-get-paid-when-the-money-comes-in 

projects. I had an amazing time there; I learned 

so much. When I think back about that time I get 

that craving, nostalgic feeling where everything 

in the past used to be better [Laughs]! No, but 

really, I had great artists around me, an amazing 

art director, fantastic projects, and the company 

atmosphere was open and creative. It really got 

me ready for the big, bad games world, I guess. 

went back to work there on several occasions, 

both during and after my studies. 

At a certain point I got asked to work for 

Guerrilla Games. They where looking for 

a character artist, so I jumped in there and 

worked on Killzone 2. That was quite a different 

experience from W!Games; a big company, 

owned by Sony, working on a project of an 

incredible size and joining at a late stage of 

”It really got me ready for 
the big, bad games world, 

I guess.”

http://www.2dartistmag.com
http://www.davidsmit.com/cv.html
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– and having all the freedom. If only I could 

understand my team though, that would make 

things a lot easier [Smiles].

So that’s a bit about my work experience, so far. 

What changed? Well, two things for me: one, 

on a more industry level, I think over the last 

few years there has been a sudden realization 

all over the industry that there are a lot of game 

companies and games being made. And with 

that comes the commercial side of safety – in 

other words: no cojones!

For me, I think I’m a bit more confident and sure 

about what I want and don’t want. I still want 

everything, to do everything, see everything, 

and make everything. But I know now that there 

are places where I’m doing work filled with 

development. All very different from what I was 

used to, but all very good experience – great 

people and an amazing project! 

I realised there, though, that I like to be a bit 

freer in terms of creativity. I like to be more 

involved in the core of the whole thing. Of 

course, I joined when the game was well into 

its development, so opting for purple-clad girls 

amongst gray hellghast soldiers wasn’t going 

to work. Anyhow, during all this I did some 

freelancing as well. And then at one point I 

decided to combine freelancing with travel 

around the world for a bit – for about 12 months 

so far. It’s been great fun touring in a small 

van through the mountains of New Zealand, 

enjoying a beer in the jungle at Byron Bay, 

Australia, while freelancing to pay for the next 

day. And then there was an email from a friend 

from my studies asking me if I wanted to work in 

Vietnam as an Art Director. I thought: Why not? 

That’s the best motto ever by the way; it works 

for just about everything! It was something 

different. Setting up a whole project – and team 

passion and motivation, and there are places 

where I’m doing a job, just a job. So my goal 

now is to keep working at the places where work 

is not a job, but a passion. 

Wow, I think you may have just become a hero 

to many! As a fellow child of the 80s, what 

inspired you as a child growing up through the 

90s and into the noughties, where you emerged 

as a young adult, fresh-faced and ready to face 

the art world? 

Good year, obviously! Phew. That’s a hard 

question to answer… What laid the foundation, 

and inspired me in the younger years? In one 

word: LEGO! Since you’re from the same year 

there’s a good chance you are also a Lego child. 

Am I right? Don’t deny it! 

I love Lego; it allowed me to do whatever I 

wanted. When I was younger I always used to 

build my concepts: trap doors on a deserted 

island with marbles rolling down the hill; if you 

pushed something, ropes and wheels would 

start moving and turning. Great fun to build! I 

“Building the concept was 
the most fun! That’s where 

the whole “creating 
concepts” thing started 

for me, I think.”

http://www.2dartistmag.com


made up all kinds of stories for the adventurers 

walking around down there… Of course, once 

I’d built it and it turned out to work, I destroyed 

it. Building the concept was the most fun! That’s 

where the whole “creating concepts” thing 

started for me, I think. 

During high school and the teen frustration 

years I left Lego behind – most of the time – and 

the creations came about more in the shape of 

theories about life and death. Actual drawing 

didn’t start until much later, somewhere around 

15 or 16, I think. At that age I actually wanted to 

become a 3D artist… I’ve never been very good 

at sticking to plans. 

Yep, you’re right; my parents would often find 

me under the dining table playing with Lego, 

fighting my brother for the best pieces! If you 

were to get all your retro Lego back out right 

now, and let your mind and building blocks go 

crazy, what would you build, and why?

Are we actually talking about Lego? [Laughs]. 

When we were talking about doing this interview 

I would never have imagined we’d go there! 

What I would make now…? I had three huge 

boxes full of normal Lego, one and a half of 

technical Lego, and some other Lego-like 

stuff. I had a lot! So if I had that now, what 

would I make...? It would, without any doubt, 

be something completely over the top! I think I 

would build the robot I’m working on now for the 
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project in Vietnam. I can’t say too much about it, 

but it’s not your typical serious mech. I would try 

to make it actually walkable (and probably pink 

– if I have any pink blocks). And once I have 

that one, I would make the whole environment, 

and then the other robots, and then the sewers 

underneath, and then the robot-rats living in the 

sewers, and then the ground around the sewers, 

and then the robot-dino bones in the ground, 

and then an underground civilization, unknown 

to mankind. And then... oh boy, where’s the 

Lego?! I would pretty much just go concepting 

with it. Before finishing one thing I would start 

breaking it down for the next idea. You got me 

all excited... I’m not sure if they know about 

Lego here in Vietnam? Hmm, I might have a 

look for some tomorrow. 

Err, yeah, sorry, we love Lego – we were just 

saying the other day it would be cool to get 

some Lego sets as extra prizes for some of 

our forum competitions! [Grins]. Ok, so moving 

on, you’ve got a very impressive educational 

background – graphic design, game design and 

development, art history, and art in European 

media are all proudly sitting on your CV, waving 

at me. In your eight years of art education, what 

have been the most notable experiences, and 

how useful have each of these courses been in 

helping you to find your path as an artist in this 

fast-paced craziness we call our world?

Hey, when you sum it up like that it does sound 

like a lot! [Smiles]. The thing is with all those 

qualifications and studies, they interested me at 

the time, but in my mind they were not “perfect” 

in terms of education. I chose to do them 

anyway because I felt that they where closest to 

what I wanted to do, or at least had the potential 

to send me in the right direction. So they were 

all sort of interesting, but not quite exactly what 

I really wanted. In hindsight though, they were 

all fundamental building blocks for where I am 

today – and I quite like where I am!  

See, for all that education, I actually had very 

little art education. Let me try to explain that a 

bit… Graphic design was mainly multimedia, 

typography etc. I went to art school to study 

game design and development; art history 

was just text, and my MA in European media 

was research. So out of all those studies, I 

perhaps only had three classes over a few 

weeks of proper art training – meaning how to 

hold a pencil! As an “artist” that leaves me very 

uneducated in the formal trainings of the arts, 

but very versatile and broadly educated in terms 

of tools, techniques, management, development 

and mindset. And for the position where I am 

now – concept artist/illustrator/art director – that 

is very important. Most of the actual drawing 

techniques, I had to learn myself. Unfortunately 

that makes me not suitable to be the world’s 

best artist, but hopefully it does put me on a 

path to create some very interesting projects 

– games, movies, comics, cereal boxes, you 

name it! 

It all sort of fits together in the end, I guess. Or 

maybe I should say “it all fits together in the 

beginning”, because I’m just getting started! 

Indeed you are! I think it’s quite common for 

people to find that they don’t quite get the hands 

on art training they really need during their art 

studies – I think I had only four life drawing 

classes over a three-year fine art degree! 

Pretty crazy, really! I’m sure there are people 

out there who are also trying to learn art skills 

independently, so can you tell us a little about 

how you motivated yourself, and where you 

went to source your information, research etc?

Well first of all I think it’s mainly that people think 

they are not getting the art training that they 

think they need. It depends on who and what 

you want to do of course. If you are aiming to be 

the best artist in the world in terms of rendering 

as much detail as possible, as close to realism 

as possible, preferably as fast as possible, then 

maybe some hands on art training would be 

useful. But for concept art and design, it’s much 

“But for concept art and 
design, it’s much more 

about getting the mindset 
and developing your 

creativity.”

http://www.2dartistmag.com
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more about getting the mindset and developing 

your creativity. That means that you are going 

to get less training (normally, at least) in holding 

a pencil or drawing muscles exactly right, 

but more in generating ideas across a broad 

spectrum of fields. 

Of course, hands on art training is very good 

to have. It’s just common for students or ex-

students to neglect all the mindset, creativity 

and methodology training they get over the 

years and only focus on the simple, measurable 

“drawing” skills. But then again, it feels 

nowadays that the industry is going more and 

more towards a massive request of beautiful – 

but the same – images. And that, unfortunately, 

is now considered concept art. So getting really 

good at rendering might actually be the key for a 

lot of people. 

Eh, oh yeah, let’s stay on topic. Err, well I 

don’t really learn independently, because that 

means sitting in your room with no windows and 

internet and figuring everything out yourself… 

The internet and the collectives that offer 

knowledge are such amazing tools right now. 

I mean, the internet offers all the information 

from the best sources (for you) in the world! The 

whole world! And it gets checked and cross-

referenced by everybody to see if it’s correct. 

If you study traditionally, you’re only as good 

as your teachers. And trust me: teachers can 

be wrong. Yes, just like your parents, and once 

you admit that to yourself the world is much 

less fun! The only thing is that people now, 

learning without an art academy to tell them 

what to do, often skip all the boring parts. But 

those boring parts are the fundamentals of your 

whole art future. That is important to realize. 

And people tend to have a really short horizon if 

self-educated, because they only look at things 

they already like and know. So I do think getting 

some education, even if it’s not art, is very, very 

valuable for an artist. 

Next to that is to find a crowd of people who 

share the same interests, but don’t exactly like 

what you like. So your horizon broadens. And 

it’s even better to surround yourself with people 

who are better than you are. Much, much better! 

Get an internship, go train with a traditional 

artist, and go to workshops. Any and every bit 

of information that I could grab, I did. Since 

nobody laid the important information out for 

me, I just went with the “any information is good 

information” route. It’s the same for any form of 

training, and I think competitions are a great way 

to get a way of working down, to motivate you to 

make things, and build up a portfolio. They push 

you creatively – well, sort of – and give you a 

deadline. 

So let’s talk portfolios! And what a portfolio?! 

Browsing through your work it’s clear to 

see you know your stuff when it comes to 

composition, framing, and lighting. Really great 

skill throughout! I also love how you render your 

human skin tones – you have such a beautiful 

way of capturing life in your characters through 

your brushwork. Could you perhaps give us a 

little walkthrough on how you would create your 

palette and paint your skins?

Thank you for that! My palette tends to change 

quite a lot, from black and white to full on 

Disney. It’s always about the bigger concept. 

I always try to choose a palette that fits the 

general feel of the image. It also really depends 

on what inspires me at that time, so there isn’t 

really a clear answer for that palette question.

“It’s even better to surround 
yourself with people who 
are better than you are. 

Much, much better!”

http://www.2dartistmag.com
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For me, faces are the most interesting part of a 

whole illustration. They say it all. At least 50% 

of the time spent creating an image is just on 

the face, or faces. Getting the eyes and mouth 

right is somehow very important for me. When 

I paint a face, or a tree for that matter, I see it 

more as sculpting: I’m constantly pushing things 

back and pulling things forward. And one of the 

important things I find when painting faces is to 

keep things moving. Especially because skin is 

never really just one color or value. And if you 

keep pushing things around you get variation! 

So painting my skins usually takes some time; 

I prefer to use big brushes because they give 

such a nice direction to your strokes. It keeps 

things moving and dynamic. 

Sure, you certainly have a very diverse portfolio 

– I meant the palette question for the skin tones, 

but guess I didn’t ask the question just right. 

Sorry about that! So you mentioned before you 

originally wanted to be a 3D artist, and you tell 

us that you see painting almost as sculpting, so 

do you currently do any 3D right now? Dabbled 

in ZBrush at all? Any plans to do so, if not 

already?

I actually do use 3D a little bit now and then, 

but mainly for concepting. It’s a really good 

way to show people exactly what you mean in 

3D, especially with difficult curves, shapes and 

details that are composition- or design-wise very 

important, but hard to grasp from a 2D picture. 

Another way of producing concept art, I guess. 

Funnily enough, I’m still used to the old school 

low poly modeling. I probably could get used to 

the likes of ZBrush and Mudbox, but I’m afraid 

I’ll like it too much and spend all my free time 

doing that instead!

Aww, I guess it’s the classic case of not enough 

time in the day for everything we’d love to do, 

hey! We’ve noticed in the past that you’ve been 

quite keen on entering community challenges; 

what is it about these that get you excited? Is 

there a particular kind of brief that really gets 

your Wacom going, or are you pretty much up 

for any challenge, whatever the topic? How do 

you find these challenges help you as an artist? 

Sharp observation! I guess I just want to win 

one [Smiles]. I am pretty much up for any topic 

http://www.2dartistmag.com
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and brief, really. I think challenges are a great 

way to keep working on new things and refining 

your skills. You could do the same without those 

challenges I guess, but then the possibilities are 

endless and so nothing comes out. It’s scary, 

just like an empty, white sheet of paper. So in a 

way, I need those challenges to set borders for 

me, to give me focus. 

But I wouldn’t say that they particularly get me 

really excited. I like to make illustrations for 

those competitions but the choice of topics and 

briefs get me annoyed sometimes. It’s always 

something like, “create a dark knight fighting 

a horde of undead orcs with his glowing super 

power sword”. Or the exact opposite which 

doesn’t say anything except, “imply epicness”. I 

hate those topics! What the hell am I supposed 

to do with that? Create the exact same orc as 

the other guys, just rendered slightly differently? 

See, although I really would like to win a 

challenge, I don’t see it happening soon. I 

always try to find the edges of the assignment, 

to do exactly that what they won’t expect – 

mainly to take the subject and the whole design/

painting topic not too seriously. But that makes 

my chances of winning very low. I don’t know, 

I guess I’m just one of those people that will 

always do the opposite to the majority! 

And oh, oh, oh, I’ve just seen that the results of 

the last Secret Agent competition are in ... Oh! 

Hmm … nothing! No win, not even a mention 

in the honorable mentions. Ah well, I saw it 

coming. At least I created another image for my 

portfolio, though [Wry smile].

Sorry about the challenge; you won us over with 

your image anyway! [Grins]. Sounds to me like 

you’re a true artist – that’s what it’s all about, 

right? Pushing the boundaries and finding the 

opportunities to draw on the unexpected is what 

makes it so much fun! Who wants to be part of 

the herd anyway? [Winks]. So my final question: 

If you could write any brief for any art challenge, 

what would it be, and what would you answer 

the brief with if you were to create an entry?

[Laughs] A true artist… Most people who meet 

me and don’t know what I do don’t even guess 

I’m anything like an artist. So in the public eye 

http://www.2dartistmag.com
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I’m not really a weird arty guy. But in the core of 

my being, the center of my person, I don’t really 

care if I’m an artist or a programmer. I’ll do what 

I’ll do. 

That question’s got me thinking a lot though, 

about a good competition brief. I think I’d try to 

push people out of their boxes, make it hard on 

them – maybe something like the next fantasy or 

imaginary world? Something like a steampunk 

world, since that’s what people like! And of 

course, you need people to get a competition 

going. But anything that includes or even 

resembles steampunk, elves, orcs, dragons, 

any form of traditional Tolkien or Warhammer 

fantasy, space marines, space ships, typical 

speed painting, superheroes, dinosaurs, ninjas, 

or pirates – eh, no, on second thoughts pirates 

are allowed – will be disqualified. There will be a 

separate page with all the disqualified works on 

there, and a top 10 of the most cliché ones! 

I think the world needs some new creative 

worlds so people can start copying that into 

eternity instead of the same, age-old stuff. 

Of course, I’m not going to say what I’ll do, 

because I don’t know [Laughs]. Such a brief is 

made so that people have to think for a bit, and 

not just speed paint their way through it. It’s a 

tough one, I think, especially when I would be 

the judge. 

Blimey, a steampunk world without steampunk 

– that’ll be a tough one! But I like your way of 

thinking in terms of wanting to push people to 

think outside the box. Told you: true artist! We 

can tell you are at heart anyway, even if you 

don’t appear to be on the outside. And on that 

note, it’s been great chatting to you David, even 

if I’m a little unsure how much of this interview is 

tinged with sarcasm [Winks]. Thanks again, I’ll 

talk to you soon. Take care!

David Smit
For more work by this artist please visit:

http://www.davidsmit.com 

Or contact them at:

david@davidsmit.com

Interviewed by: Lynette Clee

http://www.2dartistmag.com
http://www.davidsmit.com
mailto:david@davidsmit.com
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“I found it 
interesting 

how things in 
the back of 

my mind would 
be pulled 

forward by 
looking deep 

into something 
that I drew 

with my eyes 
closed!”



Sketchbook of 
John U. Abrahamson

from this primordial soup of lines and scratches were 

laced with the aforementioned encounters. 

The entire series is built upon what I was able to 

pull from automatism exercises filtered through my 

emotions and life experiences.  Once a figure was 

developed in this manner, I would push and pull the 

concept in as many directions as possible. At the end 

of a session I would find the images that spoke with 

the loudest and most precise voice. The end result 

was a more liberated and more successful series. 

This process of using nothing but sketches as the 

basis for the work allowed for a more 

freeform association, resulting in 

a world populated with creatures 

that carried with them the very 

essence of myself.

Sketches
Cigarette Burns

This started with a scribbled 

circle which 

developed into 

a stomach 

and breasts 

(Fig.01). A 

quick curved 

slash to show 

gesture turned into 

the tube emanating 

from the crotch. 

Shading 

scratches 

developed into 

the spikes in 

the arms, or 

the “cigarette 

burns” when 

I translated it 

to paint. The 

automatic 

drawing base 

suggested to me 

a painful period in my life when I 

was going through a divorce and had a 

lot of inner guilt which I turned to self-

mutilation, such as cigarette burning.   

                     Process 
       This article is based on sketches created for

a series of works which have come to be 

collectively known as “Flesh and Blood”. 

In my previous work I’ve used limited 

sketching as a way to flesh out what 

I had already envisioned in my head. 

I had thought out every detail of the 

painting ahead of sketching, primarily 

working from source material such as 

photographs from books, magazines, and 

ads that I would gather before I began a new 

series. I would pour over the images until a 

direction presented itself; I would do rough 

sketches to work out composition and other 

visual problems, doing the finished sketch 

on the canvas itself…

For the “Flesh and Blood” series I chose to take a whole new approach to the process 

of creating. I started with some base parameters that formed the framework that I would 

build upon. This framework was a product of several experiences that happened as I 

began Flesh and Blood. 

The first happened at the De Young Art Museum in Golden Gate Park of San 

Francisco. The place was packed with people. I was hoping to get some spark of 

inspiration from their collection. When passing by all the patrons buying tickets, I 

saw a stunningly beautiful woman; both her arms had been amputated mid bicep 

with exposed bone protruding from the end of the tapered muscle. She was in a 

wheelchair and having a seemingly wonderful time with her friends. I found her to 

be both perfect and transcendent.

The other defining visual was at Filoli, a marvelous mansion from the 1800s which 

is now a museum in the San Francisco area. In the gardens of Filoli we came across 

some apple and pear trees that had been trellised when they were mere saplings. 

Throughout the many years they stood as the flesh of the trees grew around the 

armature. Metal polls protruded from the flesh of the trees like arms; this, to me, 

was reminiscent of the woman at the De Young.

The sketches for Flesh and Blood began with automatic drawing. I filled page after 

page with nothing but automatic drawings. The figures that slowly began to emerge 



Angels of Death 

With the birth of my son and my ever aging 

body, my own mortality is always very close 

to the surface. In one session of automatism 

exercises, these two figures came out of 

the chaos of scribbles (Fig.02); the lower 

representing cancer, and the top figure liver 

damage (the latter developed into the painting 

now known as “Damage”). I suppose these 

are two possible ways that I will meet my 

demise. I found it interesting how things in the 

back of my mind would be pulled forward by 

looking deep into something that I drew with 

my eyes closed!
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Mother Issues

My mother disappeared when I was 

seven and my sister was five; we didn’t 

know if she was alive or dead. No one 

said anything about her and she faded 

from memory. I found her when I was 

18. This issue is repeated through every 

series I have ever done. I will say that 

this sketch was more intentioned than 

the others; I did set out to do a portrait 

of dear old mom. The body head and 

spikes were well established vocabulary 

by the time I did this sketch. This is 

probably the most from-the-gut-and-

accurate portrait I have done of her 

(Fig.03).

Portrait of my Ex wife

This was a more freeform drawing – 

automatic drawing developed out and 

elaborated upon. The first image was 

my ex-wife. She was disabled and 

addicted to Morphine. The head started 

as a pincer like head, but it developed 

to have more sexual connotations. The 

most important thing about this sketch is 

the flow of the development of an idea, 

as shown when read from left to right 

(Fig.04).

“I often feel 
that the 

drawing leads 
me, not the 
other way 
around.”

http://www.2dartistmag.com


The Red Door

The female figure suggested the male figure 

(Fig.05); I did not intend to do a couple, one 

development simply led to the next. I find this an 

invaluable tool: looking at the lines, intended or 

not, and seeing what they suggest. I often feel 

that the drawing leads me, not the other way 

around.



At the Altar of Needles

This is an interesting sketch for me because the 

finished painting varied more from the sketch than any 

other painting I did (Fig.06); usually the painting was 

an exact reproduction of the sketch. An entire birthing 

apparatus was added after I painted the sketch as it 

appeared in my sketchbook. I don’t know this for fact 

but I believe my subconscious was pushing dear old 

mom in front again.
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Untitled 

This sketch was never used as a painting, but 

it’s important in so far as it was the first time a 

prevalent image came into the work (Fig.07). 

The legs transforming 

into stilt-like apparatus 

was, I believe, born 

out of my natural tendency to 

make cruciform. The image 

continued to show up in the 

work even when this was 

not the effect the stilts had. I 

associate with an idea or image 

and sometimes it can be years 

after the fact that I will look at a 

drawing or painting and see the 

intent behind it – something I 

was not consciously aware of at 

the time of creation!

http://www.2dartistmag.com


In the Theater of Teeth

The final painting was a combination of this figure and another from 

a totally different drawing session; different from all others because 

it was directly related to a pre-existing image. I was going through 

an anatomy book just to reacquaint myself with the muscle structure 

of the back when this came to me.

Note from the 
editor:
John U. Abrahamson’s “Flesh and Blood” will open 

March 10th at Bert Green Fine Art in Los Angeles, 

CA, USA. For more information, please visit:

http://www.bgfa.us

http://www.JohnUA.com

John U. 
Abrahamson
For more information please visit

http://www.JohnUA.com

http://fleshendblood.blogspot.com 

or contact

jua@johnua.com

http://www.JohnUA.com
http://fleshendblood.blogspot.com
mailto:jua@johnua.com
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Amanita Design are a small, independent game development studio 

located somewhere in the Czech Republic. Since the company first 

formed in 2003, they’ve managed to stock-pile an impressive list of 

accolades and awards, the latest being for their first full-length flash game, 

Machinarium, which won the Excellence in Visual Art award at the 2009 

Independent Games Festival. We recently got the chance to catch up with 

this up-and-coming company and find out more about what makes them 

tick and why their website has been overrun by mushrooms...

“We had to invent the art style quite precisely: the 
pictures were going to be hand-drawn by pencil to make 
them feel really hand-made. Adolf is very precise, which 
was a bit problem because we wanted more relaxed 
drawings. I told him many times that he shouldn’t draw 
too perfectly so he started to draw with his clumsier left 
hand!”
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Machinarium - Interview 
with Amanita Design
Can you tell us a little bit of history about 

Amanita Design? Where did it all begin and how 

has it evolved since?

Amanita Design started in 2003 when I 

graduated from the Academy of Arts in Prague 

with a free online flash game called Samorost 

as my thesis project. In 2005 I was joined by 

the studio animator Vaclav Blin and Samorost2 

was created. Since then we have found several 

excellent collaborators - musician Tomas 

“Floex” Dvorak, programmer David Oliva, 

painter Adolf Lachman, sound maker Tomas 

“Pif” Dvorak and animator Jaromir Plachy. 

Besides independent and commissioned flash 

games (Samorost1, Samorost2, The Quest 

For The Rest, Rocketman VC, Questionaut) 

the studio has also created a couple of music 

videos (Plantage, Na tu svatbu),  websites, 

animations, illustrations and production designs. 

Now we are focused mainly on games, 

but most of us also have some side 

projects. Vaclav Blin is preparing 

a very strange interactive music 

video, I’m working on production 

design for an animated feature 

film, Adolf Lachman is a freelance 

painter and sculptor etc.

It sounds like you have an awesome core 

team, each bringing their unique skills. Are you 

planning to expand further? Do you have any 

big ambitions or dreams of what you would like 

to achieve with your studio?

If we do expand, then it will only be a little, or 

very slowly. We want to keep the team small 

and mainly based on friendship and very close 

collaboration. As for our ambitions, we are not 

heading towards some huge AAA titles; we want 

to make smaller projects and experiment more 

with game design, storytelling and the visual 

form.

Now then, from all at 3DTotal - congratulations! 

Machinarium (http://machinarium.net/) has 

received so much fantastic praise, backed up 

with awards and top reviews … how does it all 

make you feel?

The reviews and direct feedback from players 

“We want to keep the team small and mainly based on 
friendship and very close collaboration.”

http://www.2dartistmag.com
http://machinarium.net
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are really awesome. It’s much better than we 

hoped for and of course we are happy. It also 

gives us more self-confidence to continue in 

games development and try to experiment more 

with some gameplay mechanics and design 

decisions.

Will you always stick to the PC format? Have 

you considered other very popular upcoming 

platforms, such as the iphone?

Of course we are also interested in other 

platforms, especially consoles which have their 

own unique motion controllers like the Wii. Xbox 

will have Natal soon and Playstation are also 

planning a new controller, so there’s plenty of 

keep us busy. Mobile devices are also quite 

nice, but we are not sure which way to go yet.

With a game like Machinarium, how many 

people work on it, what are their roles and how 

long does it take?

The development from first sketches to finished 

game took us almost three years and it’s the 

work of seven people. I was the designer and 

director, Vaclav Blin was the main animator, 

the backgrounds painter was Adolf Lachman, 

the music composer Tomas ‘Floex’ Dvorak, 

the sound maker Tomas ‘Pif’ Dvorak, the 

programmer David Oliva and the second 

animator was Jara Plachy.

Okay, onto Machinarium’s visuals - 

which are simply stunning, emotive 

and fascinating by the way! Where 

does all the inspiration come from?

When I was designing the 

Machinarium world I was strongly 

inspired by old rusty machines, 

abandoned factories and industrial 

“I was strongly inspired by old rusty machines, abandoned 
factories and industrial buildings.”

http://www.2dartistmag.com
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Of course we also wanted many tiny details 

in the final pictures, so we added textures 

to the drawings. The textures were usually 

photos from collections that myself of Adolf had 

gathered over the years.

I think you are absolutely right and the style 

you have finished with adds a lot to the game. 

I think the style also has a 

childlike innocence to it, 

is this what you had 

intended?

Yeah, definitely. 

The story is 

a little naive 

so it’s one 

world and 

one style - everything has to work together well 

to produce the final experience.

Changing the subject slightly: what’s the deal 

with the toadstools? They seem to pop-up 

quite a lot on your company’s site http://www.

amanitadesign.com/

Yeah, we love them! Amanita muscaria is the 

Latin name for that red toadstool (fly agaric). It’s 

a nice mushroom and when ingested it’s also 

hallucinogenic and visionary!

What would you do if one day you were walking 

in the woods and you found a giant mushroom 

that was as big as a house and living inside it 

were little inquisitive goblin-type people?

Then I would say to myself “I shouldn’t eat that 

buildings. Of course besides this direct 

inspiration I was influenced by many artists, 

filmmakers and also writers (Yuri Norstein, Karel 

Zeman, Stanislav Lem, Jules Verne, Leonardo 

da Vinci, Max Ernst and many many others).

Do you think you will continue this style into 

future games or go off in a different direction?

I think we will continue in the similar direction, 

but of course we want to be as innovative 

as possible and so our style may evolve into 

something else.

What software was used to produce the visuals 

and do you have any tips and tricks you would 

like to reveal to the readers?

The backgrounds were hand-drawn by pencil 

on paper, then scanned, colored and finished 

in Photoshop. I don’t think we used any 

special secret tricks however there are several 

important things. First of all we had to invent the 

art style quite precisely: the pictures were going 

to be hand-drawn by pencil to make them feel 

really hand-made. Adolf is very precise, which 

was a bit problem because we wanted more 

relaxed drawings. I told him many times that 

he shouldn’t draw too perfectly so he started to 

draw with his clumsier left hand! Maybe that was 

the magic trick, because 

then it started to be 

much more suitable 

for our needs. 

“It’s a nice mushroom 
and when ingested it’s 

also hallucinogenic and 
visionary!”

http://www.2dartistmag.com
http://www.amanitadesign.com
http://www.amanitadesign.com
http://www.youtube.com/watch?v=ltAohRhP1Oc
http://www.youtube.com/watch?v=uwZBdWRSBRs
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many mushrooms next time” [Laughs]. However 

I would be absolutely happy and go in for a cup 

of tea with the goblins.

Are you taking some time out after 

Machinarium? What about future projects; what 

can we look forward to next?

Some vacation would be really nice, but it’s still 

impossible to find free time these days. We have 

some general ideas for the next game, but it’s 

still too soon to tell what it will be and when we 

will start working on it.

Well whatever you guys come up with next all 

the team here at 3DTotal can’t wait to see it! 

Thanks for your time Jakub, it’s been a pleasure 

chatting to you.

Amanita Design 
Jakub Dvorský & Adolf Lachman
For more information please visit:

http://www.amanitadesign.com 

http://machinarium.net/demo/

Or contact:

contact@amanitadesign.com

Article courtesy:  Tom Greenway

http://www.2dartistmag.com
http://www.amanitadesign.com
http://machinarium.net/demo/
mailto:contact@amanitadesign.com
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This Month we Feature Artowrk from:

Branko Bistrovic

Vlad “Duke” Kuprienko

Hatice Bayramoglu

Roberto Oleotto 

Jone L. Leung

Alex Broeckel

Soheil Danesh E.

Andreas Rocha

Alex Negrea

Jama Jurabaev
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Peaceful Day
Andreas Rocha

http://www.andreasrocha.com/ 

rocha.andreas@gmail.com 

(Above)

The Confrontation
Jone L. Leung

http://www.lwcl.darkfathom.com 

eknerwal@gmail.com

(Below)

http://www.2dartistmag.com
mailto:gallery@zoopublishing.com
http://www.andreasrocha.com/
mailto:rocha.andreas@gmail.com
http://www.lwcl.darkfathom.com
mailto:eknerwal@gmail.com


The Force
Alex Broeckel

http://www.alexbroeckel.com 

alexbroeckel@gmail.com

http://www.alexbroeckel.com
mailto:alexbroeckel@gmail.com
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Just a 
daydream
Hatice Bayramoglu

http://www.3d2dizayn.com/

3d2dizayn@gmail.com

(Left)

Lachin
Roberto Oleotto

http://onthesign.it/ 

on@onthesign.it

(Above)

http://www.2dartistmag.com
mailto:gallery@zoopublishing.com
http://www.3d2dizayn.com/
mailto:3d2dizayn@gmail.com
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The Beast
Jama Jurabaev

http://jamajurabaev.daportfolio.com 

http://jamajurabaev.deviantart.com

jama_art@tag.tj

http://www.2dartistmag.com
mailto:gallery@zoopublishing.com
http://jamajurabaev.daportfolio.com
http://jamajurabaev.deviantart.com
mailto:jama_art@tag.tj
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Hyper Dream
Alex Negrea

wwritza666@yahoo.com

(Above)

In Red and Green
Vlad “Duke” Kuprienko

http://www.3dreamlab.com

admin@3dreamlab.com

(Top Right)

Dr. Malice 
Branko Bistrovic

http://branko.cgsociety.org/gallery/ 

bisvic@gmail.com

(Right)

http://www.2dartistmag.com
mailto:gallery@zoopublishing.com
mailto:wwritza666@yahoo.com
http://www.3dreamlab.com
mailto:admin@3dreamlab.com
http://branko.cgsociety.org/gallery/
mailto:bisvic@gmail.com


Garshasp,The Monster Slayer
Soheil Danesh E.

http://danesh.cghub.com 

soheildan@gmail.com

http://danesh.cghub.com
mailto:soheildan@gmail.com


VFS animation & ViSual eFFectS alumni creditS in 2009 include 9 mike dharney, animator 2012 Jamie Bowers, texture artist 

Zeke norton, Previsualization Supervisor | anuj Patil, Senior technical director | christine Peterson, digital compositor 50 Cent: 

Blood on the Sand (VG) Giorgio Bertolone, creature technical director Aliens in the Attic rex ahn, Pre-Visualization 

lead | craig calvert, cG Supervisor | Julianna Kolakis, character designer | Ben Sanders, Supervising animator | rommel Shamoun, 

compositor | noel Wright, digital compositor | adam Yaniv, animation Supervisor Alvin & the Chipmunks: The Squeakuel 

nicholas augello, technical animator | christopher downs, technical animator | amy lu, animator | adam Yaniv, animation 

Supervisor Amelia armando Velazquez, digital compositor | clement Yip, animator America’s Army 3 (VG) matthew turner, 

artist Angels & Demons craig calvert, Pre-Visualization artist | Jessica Wan, lead rotoscope artist | noel Wright, digital 

compositor Armored riley Benard, digital compositor | Yuta Shimizu, Visual effects artist Astro Boy andreas Hikel, layout artist 

Kim ooi, animation director Avatar michael cozens, lead animator | tamir diab, technical director | aaron Gilman, character 

animator | alfredo luzardo, layout technical director | Ben Sanders, animator  The Beatles: Rock Band (VG) mike Krentz, ui artist 

Brütal Legend (VG) marke Pedersen, Senior artist Case 39 riley Benard, digital compositor | craig calvert, cG Supervisor | matthias 

lowry, Visual effects | Fion mok, matchmove artist | teh-wei Yeh, matchmove artist Cirque du Freak: The Vampire’s Assistant 

nicholas augello, technical animator | Julianna Kolakis, character designer | ai Saimoto, lighting lead Cloudy with a Chance of 

Meatballs andrew lawson, animator | arun ram-mohan, Senior color and lighting technical director Coraline Brian demoskoff, animator 

A Christmas Carol Kirk chantraine, motion capture technical director | Joel Pennington, motion capture technical director | Shraga 

Weiss, character modeler | Brent Wong, character modeler District 9 neill 

Blomkamp, director/co-Writer | Jelmer Boskma, modeler | robert Bourgeault, 

lighting lead | Freddy chavez, Visual effects compositor | dominic cheung, 

lighting technical director | Paul copeland, Visual effects artist | anthony di ninno, animator | Brian Harder, creature rigger | Bernhard Huber, 

effects animator | Brett ineson, motion capture Supervisor | Steve Johnston, render Wrangler | Patrick Kalyn, animator | Bernhard Kimbacher, 

Visual effects data coordinator/compositor | Julianna Kolakis, creature texture Painter | adam marisett, Visual effects artist | nikolai 

michaleski, compositor | Brendon morfitt, digital artist | Fernando Pazos, animator | dan Prentice, Visual effects artist | mike rhone, Visual 

effects artist | cesar rodriguez Bautista, digital Paint & roto artist | cynthia rodriguez del castillo, digital Paint & roto artist | marc roth, Visual 

effects artist | derek Stevenson, matchmove lead | James Stewart, creature Supervisor | richard Sur, lighting technical director | anna tonrungroj, 

digital compositor | Shawn Walsh, Visual effects executive Producer | Joey Wilson, modeler/texturer | Samson Wong, matchmove artist Drag Me To 

Hell thomas Schelesny, Visual effects Supervisor Dragon Age: Origins (VG) Bobby Bath, character/creature artist | ryan lim, lead creature character 

artist | Herbert lowis, artist | Brian Sum, concept artist | nathan Zufelt, cinematic animator Escape from Planet Earth Giorgio Bertolone, creature 

technical director | anthony di ninno, layout artist | craig George, Head of Story | Gary Hendry, layout artist | nicholas Smolyn, layout artist Eureka anuj 

Patil, lead compositor | mike rhone, Visual effects artist Fast & Furious Ben dishart, texture artist | armando Velazquez, digital compositor The Final 

Destination david Yabu, animator G-Force John iskandar, lighting and compositing td | Ken Kaiser, animator | Hyun chul Jung, animator | andrew lawson, 

animator | Phan Wiantrakoon, animator Ghostbusters: The Video Game (VG) Giorgio Bertolone, creature technical director | Winston Fan, compositor | Harry 

liu, Junior motion capture editor | Jessica mih, modeler | maya Zuckerman, Visual effects artist GI Joe: The Rise of Cobra Jelmer Boskma, modeler | Patrick conaty, 

digital compositor | Ben dishart, texture Supervisor | aruna inversin, digital compositor | Julianna Kolakis, concept artist/modeler | Sean lewkiw, Visual effects 

artist | tom Piedmont, digital artist | Jeremy Stewart, Senior animator | Jeff tetzlaff, lead modeler | Jessica Wan, lead rotoscope artist Grey Gardens armando 

Velazquez, digital compositor Halo 3: ODST (VG) Bartek Kujbida, cinematic animator Harper’s Island Steve J. mcleod, digital compositor Harry Potter and 

the Half-Blood Prince Harry mukhopadhyay, lead effects technical director | Pietro Ponti, td Generalist | Gia Sadhwani, digital effects artist | Kieran tether, 

digital artist | teh-wei Yeh, lighting td Ice Age: Dawn of the Dinosaurs Scott lemmer, animator | thom roberts, animator | Brent Wong, modeler Invictus 

christopher ahrens, lighting lead | Geoffrey Hancock, Visual effects Supervisor | Sean lewkiw, digital effects Supervisor | Jason mcKeeman, lead technical 

animator | Farhad mohasseb, compositor | michelle Skrzyniarz, matchmove artist | Jose Yapor, animator Killzone 2 (VG) andrea arghinenti, technical artist 

King of the Hill michael loya, director Knowing tim rowlandson, rigging technical director | richard Sur, lighting technical director Land of the Lost 

nicholas augello, massive technical director | tony etienne, lighting Supervisor | amy lu, character animator Law Abiding Citizen Freddy chavez, 

compositor | Veronica marino, compositor | James mcPhail, effects animator | Jacob curtis miller, matchmover | Jay randall, Visual effects Supervisor 

derek Stevenson, matchmover | Shawn Walsh, Visual effects executive Producer The League of Super Evil daphne de Jesus, compositor | Barry 

Karnowski, animation Supervisor The Lord of the Rings: Conquest (VG) michelle lam, lead character artist The Lovely Bones michael cozens, Previs 

animator Monsters vs. Aliens Jiyoung lee, texture artist Night at the Museum: Battle of the Smithsonian rex ahn, Previsualization lead | nicholas 

augello, technical animator | christopher downs, technical animator | Joshua Herrig, lead lighter | Zeke norton, Previsualization Supervisor | ai 

Saimoto, lighting lead | Ben Sanders, Supervising animator | derek Stevenson, Previsualization artist | Joey Wilson, Previsualization artist | adam 

Yaniv, animation Supervisor Orphan Francisco moncayo moreno, digital artist | Shawn Walsh, Visual effects executive  Producer Paul Blart: Mall Cop 

riley Benard, digital compositor Planet 51 Sandro di Segni, Senior effects td | Jorge Kirschner torres, modeler | Gianfranco Valle, effects animator 

Prototype (VG) Harry ahn, lead cinematics animator | Bobby Bath, lead character artist Punch-Out!! (VG) nelson Garcia, concept artist Pushing 

Daisies Scott dewis, Visual effects Red Faction: Guerrilla (VG) dilber mann, Project manager Resident Evil 5 (VG) Jacob Palmer, animator Rock Band 

Unplugged (VG) mike Krentz, artist Sanctuary Julie Bergman, animator | mladen miholjcic, Visual effects artist Shorts david Yabu, animator Sorority 

Row mike rhone, Visual effects artist Star Trek aruna inversin, digital compositor | tom Piedmont, digital Plate restoration | Kieran tether, digital 

artist | teh-wei Yeh, digital artist Stargate Universe daphne de Jesus, digital compositor | Julianna Kolakis, character designer | daniel osaki, 

lead 3d modeler | anna tonrungroj, digital compositor Supernatural, daphne de Jesus, digital compositor Surrogates anthony di ninno, 

animator | Joshua Herrig, lighting artist/look dev artist | matthias lowry, digital compositor | laurie Powers, compositor | teh-wei Yeh, digital 

artist Tales of Monkey Island (VG) Jason Findley, character artist Terminator Salvation Geeta Basantani, digital matte Painter | teh-wei Yeh, 

lighting technical director Transformers: Revenge of the Fallen allen Holbrook, animator | aruna inversin, compositor | Stephen King, 

animator | Henri tan, creature technical director | Kieran tether, digital artist | teh-wei Yeh, digital artist The Twilight Saga: New Moon 

dominic cheung, lighting technical director Uncharted 2: Among Thieves (VG) mike Yosh, lead animator Underworld: Rise of the Lycans 

Pearl Hsu, 3d artist | lon molnar, Visual effects Production executive Up Bill Watral, Visual effects artist Warhammer 40,000: Dawn of 

War II (VG) ian cumming, Senior artist | allan dilks, artist | nathan Hocken, lead animator | christine Hubbard, artist | claire roberts, 

artist | Jefferson takahashi, artist Watchmen ori Ben-Shabat, compositor | Jelmer Boskma, Previs modeler | Freddy chavez, compositor | dominic 

cheung, 3d artist | Ben dishart, texture artist | ty duperron, modeler | Pearl Hsu, 3d artist | Bernhard Kimbacher, digital artist | Sean lewkiw, 

technical Head of 3d | matthias lowry, digital compositor | James mcPhail, digital effects artist | Jacob curtis miller, digital artist | lon molnar, 

Visual effects Supervisor | Harry mukhopadhyay, lead effects td | cynthia rodriguez del castillo, digital artist | derek Stevenson, matchmove 

artist | Shawn Walsh, Visual effects Supervisor | Samson Wong, compositor Wheelman (VG) laura Gorrie, Senior animator Whiteout armando 

Velazquez, digital compositor | clement Yip, animator Wolfenstein (VG) Jason martin, modeler X-Men Origins: Wolverine Geeta Basantani, 
digital matte Painter | rommel Shamoun, compositor | Jeremy Stewart, Previs artist Zombieland mike rhone, Visual effects artist

VFS student work by Thiago Martins

Your name here.

http://www.vfs.com/animationvfx


http://www.pixologic.com/?utm_source=3DTotal&utm_medium=PDF&utm_campaign=3DTotal%3A%2BPDF%20centaur
http://www.pixologic.com
http://www.pixologic.com/zbc
http://www.pixologic.com/docs


This tutorial series will revolve around the use of 3d as a starting point for digital painting. In particular we will 

explore the value of Google SketchUp, a free program enabling users to quickly build 3d environments using 

a set of intuitive tools.

This technique is used by many contemporary artists and is used as a quick and effective way of establishing 

correct perspective as well as offering a moveable camera in order to experiment with compositions.

As a 3d package SketchUp is easy to learn and does not require hours of training and as an artist wishing 

to draw complicated scenes, this approach can prove a valuable starting point for producing a template on 

which to paint over.

“I continue to lay down 
textures on the rest of the 
buildings now, still using the 
Transform Tool to fit them in 
the correct perspective.”

• Free Base Image

http://www.2dartistmag.com/tutorial_resources/issue_048_dec_2009/tutorial01/tutorial01_baseimage.zip
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Using Google SketchUp as 
a base for Digital Painting

Why use SketchUp?
Google SketchUp is a free programme enabling 

users to quickly and effectively build 3D 

environments using a number of intuitive tools. 

Unlike most 3D packages it is very easy to learn 

and does not require hours of training before 

decent results are achievable. It is very versatile 

and with regards to digital painting can prove an 

invaluable tool in swiftly establishing a correct 

perspective, as well as offering a moveable 

camera in order to experiment with alternative 

viewpoints and compositions. 

An object can be made and then duplicated 

any number of times, so if a structural element 

is repeated throughout your concept then this 

package can quickly and accurately create 

such arrays. It also has a simple-to-use lighting 

system that enables placement of the sun 

according to the month and time of day by 

way of slider bars, thus determining physically 

correct shadows that can be turned on or off at 

the click of a button. These functions mean that 

as an artist wishing to draw detailed or tricky 

scenes, one can use SketchUp as a valuable 

starting point to establish a “guide template” on 

which to paint over.

Installation
In order to install SketchUp, click on the link 

below and go to Downloads on the left hand 

menu. Select the free version which is currently 

version 7 (Fig.01). Choose your operating 

system and then follow the instructions. 

http://sketchup.google.com/

Once installed, click on the application shortcut 

and you will be prompted with the following 

dialogue box in which you are asked to choose 

a template (Fig.02). The scale and type of your 

scene will determine which you choose, but 

for the purposes of this tutorial we will select 

Architectural Design – Feet and Inches.

Toolbars and Menus
When SketchUp starts you will see a screen 

resembling Fig.03. From the main menu click 

on View > Toolbars > Large Tool Set; this will 

access more tools which will appear down the 

left margin. To change the display mode of the 

objects in the scene click on View > Face Style; 

this will show a number of options, as seen in 

Fig.04.

If you also check Views under View > Toolbars 

you will see six small house icons appear 

below your toolbar (Fig.05). These will provide 

quick access to orthographic views, as well 

as isometric. You will notice that I have also 

checked Face Style in the list (highlighted in 

green), which has added some cube icons to 

represent the display modes. 

This is basically where you can customise your 

workspace and add toolsets to speed up your 

workflow. For additional help go to Window > 

Instructor; this will open a window providing 

useful information on whichever tool you have 

currently selected.

http://www.2dartistmag.com
http://sketchup.google.com/


page 58www.2dartistmag.com Issue 048 December 2009

 Chapter 6:  Using 3D as a Base for 2D Painting

Basic Navigation
The key orientation tools you will use to navigate 

in your scene are Orbit, Pan and Zoom, which 

you will find on the top toolbar and whose 

shortcut keys are represented by O (Orbit), 

H (Pan) and Z (zoom). These can be seen in 

Fig.06.

The main tools used to directly manipulate your 

objects are Move (M), Rotate (Q) and Scale (S). 

The Scale tool appears on the left hand toolbar 

which you will see highlighted if you press S on 

your keyboard.

Drawing Shapes
One way of using SketchUp is to create two-

dimensional shapes from which you can extrude 

three-dimensional objects. Select the top view 

and then the Line tool (Fig.07) and left-click in 

the viewport to begin drawing. You will notice 

that as you do so, the points will snap to the 

green and red axes, thus easily enabling the 

creation of right-angled structures.

When you finally close the shape by clicking on 

the initial point you will notice the shape turns 

blue, indicating a surface has been made; once 

a shape has become closed you can still edit 

it, however. Using the Line tool, add an internal 

rectangle (see top diagram in Fig.08). To now 

make this edge become part of the exterior 

shape click on the Eraser tool and then on the 

outside edge shown in red.

You can continue to cut into your shape or 

alternatively extend it outwards and then erase 

the necessary lines by using the Line tool 

(Fig.09). Here I have added a walkway and 

also a curved section using the Arc tool. You 

can also draw more organic shapes using the 

Freehand tool (Fig.10).

One other useful function, especially for 

architectural structures, is the Offset tool which 

is situated next to the Rotate tool. This enables 

a shape to be duplicated in order to create 

depth – perfect for drawing walls in a building, 

for example (Fig.11).

With an exterior wall depth, click on the large 

internal shape using the Select tool (black arrow 

on Toolbar) and hit delete. You can then select 

the Push/Pull tool and then click on the wall and 

raise it vertically (Fig.12). You will notice I have 

edited the section where the walkway adjoins 

http://www.2dartistmag.com
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is above the Fog label, and to get more control 

over this function go to View > Toolbars > 

Shadows. This will place two slider bars on your 

toolbar which denote the month and time of day. 

By adjusting these you can control the position 

of the sun and direction of the shadows (Fig.16). 

There is a little icon to switch the lighting on or 

off, and besides this there is also another icon 

which opens up some extra parameters that 

alter the tonal range of the shading. You can 

the building using the Line and Eraser tools so 

that this was not raised along with the outer wall.

Three Dimensions
When a shape has been converted into 3D it 

can be edited further by using a combination 

of the Line and Push/Pull tools. If you move 

the Line tool along an edge it will snap to the 

midpoint between opposing edges (Fig.13). You 

can then make equally spaced cuts, as shown. 

These new shapes can be pushed inward or 

pulled outward, or alternatively a new shape can 

be drawn and this can then be manipulated.

In Fig.14 I have used the Offset tool to create 

a window shape in the far left rectangle. To 

create the same proportioned window in the 

other sections simply select the Offset tool 

and double-click in each rectangle. To create 

the arches use the Arc tool and then erase 

the horizontal join shown by the dotted line. 

To create windows use the Push/Pull tool to 

move the shapes inwards beyond the inner wall 

surface or until they disappear. 

Using a combination of the tools mentioned 

so far you will have the means through which 

to create and edit a wide range of forms and 

design detailed scenes.

Atmospherics & Lighting
You can add atmospheric perspective in the 

form of fog to your scene. Go to View and check 

Fog, as seen in Fig.15. You will notice that the 

edges on my building have also been switched 

off, which you can control in the menu under 

Edge Style > Display Edges.

To add lighting effects check Shadows which also control whether this affects just the object 

itself or the ground along with it and vice versa.

Additional Tools
A few other useful tools worth mentioning are 

the Tape Measure, Protractor and Dimension. 

The Tape Measure is used to draw guidelines 

which can then be traced over with the Line tool. 

In Fig.17 you can see that the tape measure 

has created the dotted lines which can be 

http://www.2dartistmag.com
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used as a guide to draw the windows an equal 

distance from the top and bottom of the block. 

To delete the lines simply use the Eraser tool.

The Protractor is used to create accurate 

angles. Move the tool to the point at which you 

wish to start the angle and you will see how it 

snaps to the three axes. Click to establish the 

correct plane and then click to begin the angle 

along the appropriate edge. Now you can set 

the angle using the guideline. In Fig.18 I have 

used the near corner as the starting point, which 

I will mirror on the opposite corner.

Once the guidelines are drawn, trace them 

using the Line tool, as with the Tape Measure. 

In Fig.19 you can see that the two angles have 

been drawn and then the Push/Pull tool was 

used to extrude a roof shape across the base 

block.

The Dimension tool simply adds a label to 

your scene, showing the distance between two 

points. Click and drag from A to B and then drag 

up or down to set your dimensions, once again 

using the Eraser tool to delete when necessary 

(Fig.20).

Cameras
The camera in SketchUp is initially placed at an 

average eye level height, so for example when 

you click on the Position Camera tool it will 

zoom in and appear around head height from 

the ground. In this sense scale is an important 

factor in your scene. 

In Fig.21 you can see a cross where I intend to 

position the camera, after which the viewpoint 

will resemble the inset image. The character has 

been placed in the scene to demonstrate the 

relationship between the scale of a character 

and the initial camera height. To adjust your 

camera, use the Look Around tool represented 

by the eye icon.

One final tool which may prove useful is the 

Section Plane tool which allows a view of a 

cross-section of your object. To use this click 

on the tool and then align the green icon to the 

corresponding plane or angle you wish to view. 

Then select the Move tool and click on one 

of the corner arrows and drag in the relevant 

direction (Fig.22).

This concludes our overview which I hope has 

at least introduced the main tools and their 

functions. There are of course further lessons 

to learn along with other tools and techniques, 

such as applying materials, but the main aim 

here is to introduce the interface and value of 

the software in terms of building a simple 3D 

environment which can then be used in digital 

painting.  

Richard Tilbury
For more from this artist visit:

http://www.richardtilburyart.com/

Or contact them at:

rich@3dtotal.com

http://www.2dartistmag.com
http://www.richardtilburyart.com
mailto:rich@3dtotal.com
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Rulers turned on, click-and-drag on the top ruler 

guide to pull down a line guide onto the horizon 

line (Fig.01a).

With the horizon line now marked out, you need 

to find where your two vanishing points will fall 

points on it. To do this, use the Line Tool and 

follow along one corner of the structure. Where 

your line meets the horizon line is your right-

hand vanishing point. Mark this with a vertical 

ruler guide (Fig.01b). 

Using 3D as a base for 2D 
Painting
Software Used: Google SketchUp and 

Photoshop

I start out with a simple 3D block-in using 

Google SketchUp, setting the camera to an 

extreme angle to give it more depth. After 

exporting the 3D model as a JPG, I open it up in 

Photoshop and resize it to around 150-200 dpi 

(Fig.00).

In Photoshop I then create two new layers for 

the left and right vanishing points. With the use 

of the Line Tool, set to Fill Pixels (Fig.01), I find 

the vanishing points of the architecture.

To find the vanishing points of the architecture, 

you first of all need to find your horizon line. The 

horizon line is basically your eye level in the 

image, or of what you’re looking at. In my image, 

I’ve left a little gap between the two cylinders to 

make this quicker for the eye to find. 

This is the where the Rulers come in handy: 

press Ctrl + R to turn them on and off. With the 

http://www.2dartistmag.com
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I hide the all the layers here, except for the two 

vanishing point ones. On a new layer I then start 

sketching in some ideas (Fig.04). At this point 

it’s a good idea to start thinking and looking 

for some textures to use (Editor’s tip: check 

The same thing goes for the left vanishing point 

– in my image this one is off the canvas. To find 

it, you need to zoom out and find where your 

Line Tool meets the horizon line (Fig.01c). 

Now that you have your two vanishing points, 

use the same Line Tool to draw lines radiating 

from the left vanishing point (Fig.01d – shown 

in red), and the right vanishing point (shown in 

green). Each vanishing point needs to be on its 

own layer.

The next step is to block in the shadowed sides 

with red using the Selection Tool and filling 

them on a separate layer. Do the same with 

the side that is facing the light, also on its own 

layer (Fig.02). I’ve used these specific colors 

just because it’s easier to see them, and when I 

need to select a side I can simply hold Ctrl and 

click the layer for an instant selection.

I now have five layers: the 3D base image, two 

layers for the vanishing points, and two for the 

shadowed/light-facing sides (Fig.03).

out 3DTotal’s new free texture and reference 

image library for royalty-free textures: http://

freetextures.3dtotal.com). 

I hide the sketch layer, and on a new layer set 

to Color I lay down some basic color and texture 

with a texture brush, just to get rid of those 

grays and to start setting the mood of the piece 

(Fig.05).

After gathering textures it’s a good idea to 

then resize them to keep a sense of scale; for 

http://www.2dartistmag.com
http://freetextures.3dtotal.com
http://freetextures.3dtotal.com
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example, you’ll need to ensure that the windows 

and doors of a texture are not too small – or too 

big! – for your scene, and likewise always avoid 

making bricks look like they’re about five feet 

long! 

So I’m starting to lay down the textures on the 

building surfaces now, using the Transform 

Tool (Ctrl + T). Right-click and set it to Distort 

(Fig.06).

I now want to place the texture on the surface 

and pull the corners of it to fit my vanishing 

points (Fig.07). 

I continue to lay down textures on the rest of 

the buildings now, still using the Transform Tool 

to fit them in the correct perspective. I’m also 

using a rock textured brush over the textures to 

unify them (Fig.08). I’m trying not to worry about 

painting over my textures; they can always be 

reapplied or replaced if necessary.

With most of the texture down now, I can start 

to add more color with the help of a new Color 

layer. I flip and re-crop the image here to take a 

http://www.2dartistmag.com
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little off the left and bring more of the train on the 

right into view (Fig.09). I’ve found a texture on 

CGTextures.com which is very useful for the old 

train; and while looking for the train texture I also 

came across a great factory reference image 

which I have decided to incorporate into my 

background, as well – also from CGTextures.

com. I’ve had to adjust the factory to fit the 

vertical vanishing point using the Transform 

Tool. 

I flip the image, and on a new layer I add 

some atmospheric fog over the distant factory 

buildings, as well as applying a few other 

textures to the walls and ground to bring out 

more detail (Fig.10 – 11). 

http://www.2dartistmag.com
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In the final steps now, I add some haze to the 

image, along with the kind of light ray you might 

see coming through the clouds on a cloudy 

day when the sun is strong! I have done this by 

simply adding a new layer, painting in my ray of 

light with a large soft brush, and setting the layer 

to Screen or overlay to achieve the right effect 

(Fig.12). This little trick adds more intensity to 

the focal area!

I tend to flatten the image at this point so I don’t 

get overwhelmed with all the layers. It also 

helps to make it feel like everything is coming 

together. And with the image flattened, I can 

now go in and add detail on a new layer. I’m 

http://www.2dartistmag.com


pretty happy with the right side of the image, 

but I find the left to be lacking in variation, so I 

darken the entire wall on the left with the Burn 

Tool, and add some additional broken glass, as 

well as lightening up the windows. This all helps 

to balance the image, with the train on the right, 

and the building on the left (Fig.13 – final).

At this stage, it’s all about how much detail you 

want to put in; you can keep adding textures 

or painting until you’re content with how things 

look and want to call it done. I’m happy with how 

things are working with this image now, so I’m 

calling it “final” and leaving it there. Thanks for 

reading!

Serg Souleiman
For more from this artist visit:

http://artofserg.com/

Or contact them at:

sergdls@gmail.com

http://artofserg.com
mailto:sergdls@gmail.com


• Free Base Image
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“The creation of adequate 
brushes is not the solution to 
a bad drawing technique, but 
the use of them will make 
our work faster and more 
effective.”

An artist’s brushes have always been a vital part of any painter’s set of tools, and remain the 

single asset that links paint with canvas. As such, they are crucial to how we view and interpret 

an artwork, and they afford the artist with a means through which to convey an idea or feeling. 

This has always been true throughout the history of art, and is no less important within a digital 

context. Software such as Photoshop and Painter essentially combine and fuse paint, canvas 

and brushes into a single tool. However, within this complex set of “tools”, brushes retain certain 

autonomy with their own, distinct set of parameters and presets, offering artists the freedom to 

affect and vary the way paint is applied. This principle of customizing brushes forms the focus of 

this set of tutorials, and aims to show how individual artists exploit these techniques to achieve 

some interesting results!

- Free Brushes

http://www.2dartistmag.com/tutorial_resources/issue_048_dec_2009/tutorial02/tutorial02_brushes.zip
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Custom Brushes - Trees, 
Leaves and Branches
Software Used: Photoshop

Introduction
Drawing any type of vegetation is not an easy 

task! One of the main problems many artists 

face is the creation of credible trees and 

brushes for their paintings. The best way to win 

this battle is to carefully observe the vegetation 

around us, and to create a set of brushes that 

will create a good effect on our canvas. 

All you need to make a good tree is your 

graphics tablet, your pen, and this tutorial! I’m 

sure that advanced painters will find some tips 

and tricks here, whilst beginners should not fear 

any of this either! So let’s get started.

Life drawing – painting 
vegetation
Trees and vegetation have been one of the 

more difficult things for artists to draw and paint. 

And the reason for this is simple: Like animals 

or humans, trees have an organic and random 

structure that can’t be easily assimilated. Most 

of the time, trees in a scene are in the middle 

or far distance. It’s for this reason that I’m 

going to focus this tutorial on painting trees and 

vegetation that will not appear too close to the 

observer.

It is important to understand that leaves, 

branches and the trunk are all parts of the same 

element: the tree. In some way, painting foliage 

is not far from painting clouds or cotton-shaped 

materials; the leaves gather together to shape 

“clouds” of leaves. It may sound very poetic, 

but keep this in mind as it will be useful for this 

tutorial.

Digital art provides artists with a useful weapon: 

brushes. The creation of adequate brushes is 

not the solution to a bad drawing technique, but 

the use of them will make our work faster and 

more effective. First of all, trust in your head; 

when you have a clear idea of what you want 

to paint, use the tools available. These kinds of 

tutorials are perfect for designing useful tools for 

your work!

As an example to illustrate this tutorial, I’ve 

selected one of my images called “Citadel”, 

which has a great combination of different types 

of vegetation elements. I’ve also selected this 

particular painting because the tree is one of the 

main elements of the composition. Moreover, 

we can see a far-off forest at the bottom of the 

image, as well as some examples of ground 

leaves and grass.

Custom brushes to draw 
leaves – Angle Jitter and 
Scattering effects
First of all, you have to know what kind of tree 

you want to paint for your scene. Pines, for 

example, are different in shape and structure 

from oaks or birches. In my own image, I 

decided to paint a rounded tree with elliptical 

leaves. The truth is that you don’t need more 

than two brushes to paint tree foliage: one is 

used to paint the grouped leaves (the compact 

mass of leaves), and another is used to paint 

scattered leaves (to paint the leaves of small 

branches and to give detail and brightness to 

foliage).

The first step is to select a photograph or image 

of grouped leaves and convert it to grayscale 

mode (Fig.01 – 02) (I recommend you gather 

photos of trees and vegetation to have a good 

collection of images that will help you to create 

brushes). We then have to edit the image to 

define it and finish around its borders (Fig.03). 

Because the leaves in the real world are never 

completely opaque, I recommend that you 

adjust the image’s Levels to reach a medium-

dark tone of gray.
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We convert the image to a brush now (Define 

Brush Preset in Photoshop’s Edit menu) and 

open up the brushes editor. As we want that the 

borders of our strokes to appear irregular, we 

have to set Angle Jitter to the maximum level. 

You can also slightly adjust the Roundness 

Jitter to get a random deformation of the leaves 

(Fig.04). Regarding the opacity, I usually control 

this with the Pen Pressure setting. Adjust it to 

your needs and paint whatever is convenient for 

you. Once you’ve completed the editing of your 

brush, and it feels good on the canvas, save the 

brush and name it (I’ve named mine “foliage 

brush”).

For the other brush of scattered leaves we need 

to isolate one leaf in the grayscale image we 

obtained earlier (Fig.05). The parameters in 

the brushes editor are the same as the foliage 

brush, only with one difference: we have to this 

time check the Scattering effe ct. Try the brush 

with different values to get a suitable result 

(Fig.06). I have named this brush, “scattered 

leaves”.

Brushes for branches – the 
Direction controller
We only need to design one more brush to 

create a tangle of branches now. Collect some 

images of trees without leaves (winter images 

of trees are perfect!) as these will be helpful. I 

prefer branches to be not too dense or complex 

(Fig.07), but this decision depends of the kind of 

tree you want to paint, of course. After removing 

the trunk and some branches, we can define our 

new brush (Fig.08).

This brush has a new and interesting effect 

in that the rotation is now being controlled 

by the stroke’s direction. Photoshop allows 

us to position the brush image depending on 

the movement and direction of our pen. You 

just have to change the Angle Jitter control 

parameter to Direction to get this working 

(Fig.09). A more precise way to do this is to 

select Pen Tilt, instead of Direction, but you 

should note that this is only applicable when 

using a pen which is sensitive to vertical 

rotation.

We can try the new brush out now and check 

how it works using the direction controller. As I 

final touch, I adjust the Spacing on the brush, 

and save it out. In my set of brushes that come 

free with this tutorial – simply click on the Free 

Resources download – you will find this brush 

labeled “branches”. 
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Using the brushes – drawing 
trees
The steps to paint a tree are easy, but you’re 

probably going to need some practice before 

you have full control over your new brushes. 

Before going any further, we have to create a 

layer for the trunk and branches, and another 

one for the foliage.

The first step is to create the branch framework 

of the tree on a new layer. In my Citadel 

painting, I draw the trunk on the top of a mound. 

I then choose the branches brush we designed 

just a moment ago, and make a clockwise 

stroke to create the basic branch structure of the 

tree (Fig.10). Don’t be afraid of the result of the 

branches brush; the placement of the leaves in 

the next step will prevent us from seeing most of 

the small parts of them. 

The next thing we need to tackle is the foliage. 

The time has now come to prove our painting 

skills! This may prove to be the more difficult 

part in this process, so take your time and try 

as many times as are required to get the results 

you want. 

We select a dark color and start painting on 

another new layer with spiral motions of our 

hand, using the foliage brush to apply leaves to 

the branches of our tree. We must be sure not 

to create foliage too near the trunk, nor on the 

border of exterior edges of branches. The best 

way to do this is to concentrate on the leaves 

in the central area. As you can see in Fig.11 I 

have deliberately left empty spaces where the 

branches appear through the masses of leaves 

(marked with circles).

Once we’ve finished with main mass, select 

the scattered leaves brush and define the outer 

border of the foliage now (Fig.12). When we 

use customized brushes, keep the brushes 
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editor open as a helpful habit. You can modify 

the Scattering effect (or any other parameter) 

quickly, according to your needs, at any time.

Finally, select lighter colors to create volume 

over the mass of leaves. “Lock transparent 

pixels” on this layer so you can be sure not to 

add more green mass unnecessarily. Use any 

brush you consider suitable to give more detail 

and definition (Fig.13). And be careful with the 

light source in the scene – as you can see in 

my image, I’ve created a backlight ambient that 

shapes the tree with dark tones of green.

The distant wooden mass – 
lighting tree crowns
Let’s move onto something a little easier now: 

the distant mass of trees. As we can see in 

most landscape paintings, the distant trees and 

woods are usually represented as an undefined 

mass without detail. The rule is simple: The 

longer the distance of an object from the 

observer, the lower the amount of detail it will 

have. In the free brushes set that come with this 

tutorial, you will find several brushes to paint 

distant vegetation.

So let’s now pass from theory to practice. Use 

the wooden mass brush to create the base 

of your wood. I’ve simply used a photograph 

of a tree to create it (Fig.14 – 15). By adding 

a Scattering effect, Angle Jitter and controlling 

the opacity with Pen Pressure, you can obtain 

lots of brushes to create a wooden mass. As 

mentioned at the beginning of this tutorial, 

vegetation arch facing down that will be very 

useful to provide volume to the plain mass we 

painted before. All we do with this brush is light 

the tree crowns. You’ll find it in the free set 

labeled as the tree border brush. Note that in 

the brushes editor, I have activated the Direction 

controller to obtain a more flexible drawing 

technique.

painting trees is similar to painting clouds or 

cotton!

To define the crown of the trees we have 

created a brush starting from another new 

photograph. As we need to see the tops of the 

trees, we can edit the image and erase the 

lower part of it (Fig.16 – 17). The result is a 
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I have compiled for this tutorial are used in 

the Citadel image, and you can download the 

brushes with this tutorial for free. Explore them 

and create your own new ones for different tree 

species for your paintings. 

My trunk roughness, grass leaves, and light 

vegetation brushes are some of the other 

vegetation brushes I have used on my, as 

you can see in Fig.19. Take a look and think 

about the different treatment of the vegetation 

elements regarding their position in the scene, 

the lighting, and the perspective (Fig.20). 

There are lots of possibilities in the creation 

of custom brushes, and I’ll be very pleased if 

this tutorial serves as inspiration to create new 

methods to face the difficult work of painting 

trees and vegetation. We could spend pages 

and pages explaining how to design brushes for 

countless purposes, but at the end of it all, the 

I have created an example in Fig.18 so you can 

see this in action. I have used only two tones 

of gray to show the advantage and simplicity of 

using this painting method. In the top image, we 

start by creating rough stains with the wooden 

mass brush to simulate volume. We then 

complete our wood by defining the borders with 

the tree border brush in the second image. It’s 

easy, really! In few seconds we’ll reach a perfect 

and realistic result without too much effort.

Custom brushes for 
everything you can imagine!
Creating custom brushes is a meticulous task 

that will bring you a new range of possibilities to 

your drawing techniques. All the custom brushes 
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most important thing is not my theory, it’s your 

practice!

Thank you for reading this tutorial, and good 

luck with your own custom brush creations!

Roberto F.Castro
For more from this artist visit:

http://robertofc.com/

Or contact them at:

contact@robertofc.com

- Free Brushes

http://robertofc.com
mailto:contact@robertofc.com
http://www.2dartistmag.com/tutorial_resources/issue_048_dec_2009/tutorial02/tutorial02_brushes.zip
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This series of tutorials focuses on mythological and legendary characters and in particular the theme of the 

undead.  It includes the two classic examples, most notably the vampire and zombie but also incorporates a 

werewolf which does occupy a very popular and unique place in modern myth. All of the above characters have 

featured heavily in both book and film contexts over the years as such have cemented themselves in history.

The tutorials cover the process of creating digital  characters from the concept stage through to the final 

refinements. The value of thumbnail sketches and exploring variations on a theme will be covered as well as 

touching upon custom brushes and the power of Photoshop’s blending modes which offer flexibility and freedom 

to edit the image throughout the design process. Each individual tutorial will take a slightly varied approach with 

regards to blocking in and color schemes and aim to show how Layers and blending modes can be manipulated to 

suit different attitudes.

“…part of the fascination 
with anything creative is the 

fact that it can suggest its 
own direction and surprise 

you on the way!”

Chapter 1 | Vampire
In the first installment we look at the vampire, 

one of the most popular characters within the 

undead category. This character has perhaps 

varied more than any other in terms of the 

guises it has adopted over the years but this 

tutorial will take the classic human form as its 

foundation, inspired by the one and only Count 

Dracula.

Chapter 2 | Issue 049 Jan 2010 | Zombie

Chapter 3 | Issue 050 Feb2010 | Werewolf
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Chapter 1 - Vampire 
Software Used: Photoshop

Introduction
Before beginning any sort of project I usually 

begin by doing a bit of research into the subject 

and gathering some reference material. In this 

case I searched Google for images relating to 

vampires and the numerous incarnations that 

have appeared over the years. When you look 

into the topic of vampires you’ll realize how 

many different interpretations exist, from the 

early vision of Count Orlok in the Nosferatu film 

through to the classic character portrayed by the 

ubiquitous Christopher Lee. Then at opposite 

end of the spectrum are the more modern takes 

that are evident in the Blade and Underworld 

series’. Suffice to say there is no single and 

consistent concept that springs to mind when 

you think of a vampire.

This poses an initial problem as I can’t decide 

in my mind what the character should look like, 

and what type of aura I want him to convey. 

Should he be a sickly, cowering type that hides 

from human contact, or have a more powerful 

and charming persona exuding status and 

sophistication? These issues led to decisions 

over the costume design and posture, and with 

so many question marks it was necessary to 

start with some thumbnail sketches to try and 

resolve the problem.

Thumbnail sketches
It’s very good practice to make a series of 

small and swift sketches before starting a final 

design as it will help clarify things and also 

suggest artistic directions that you may not have 

previously considered. In this instance I begin 

with a few silhouettes to try out some poses 

(Fig.01).

You can see here that a simple silhouette 

can convey much about a character (#1 – 3), 

providing an insight into their proportions and 

clothing, for example. I decided to make a few 

head studies to explore the type of qualities and 

look he should have, and to try and decide on 

his demeanor (Fig.02). Should he look imposing 

and more human like or perhaps be eerie with 

exaggerated features that resemble more of a 

sub-human or monster?

You can see that the top left sketch resembles 

Nosferatu (#1) and has a very different feel to 

the version seen middle-right. The bottom-left 

character looks more like a monster, whereas 

the top-right sketch looks more modern and 

contemporary in context (#2). Each has a 

different quality, and by making a series of 

sketches such as these we can begin to 

formulate an idea and turn a vague notion into a 

clearer vision.

Usually there is not one single sketch that looks 

right over and above everything else, but rather 

there are aspects that prove to be likeable in 

each. In this instance I like the more charismatic 

quality to number 4 compared to the left-hand 

column, but I also think that the long hair in 

number 2 adds a certain feminine quality which 

contrasts well with the notion of a physically 
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powerful being, lending him a certain dynamic. I 

also like the robe/cape shown bottom-right (#6) 

which adds a classic look, as well as providing a 

lyricism through the flowing lines of the fabric.

By making these quick sketches I have already 

been able to decide on a few components that I 

would like to include in my design, so I can now 

go back to the pose. The one that strikes me the 

most is number 1 (see Fig.01). It doesn’t feel 

as domineering as 2 or 3, but with the extended 

arm it seems a little creepy and mysterious, 

without being too obvious. 

Favoring this posture I begin on some variations 

(Fig.03). I have made the decision to give the 

character a robe and long hair, but if the robe 

envelops his body there will be little room for 

detail; I don’t want the majority of the concept 

to be made up entirely of this element! To add 

some interest I open the front in order to include 

some anatomy which will contrast well with the dark clothing (#1). Version 

2 looks somewhat surprised, as though he’s been disturbed and has 

looked around to face the viewer. This combined with his more hunched 

shoulders gives him a creepy quality, which I like but is not in keeping with 

a powerful presence. 

I’ve decided to add another arm to version 1 for the bottom 2 thumbnails, 

but version 3 is the one that seems to work best, as 4 appears to be too 

gestural and makes too strong a statement.

Blocking in
The first step is to add a neutral background, which I generally do by filling 

the entire canvas with a tertiary gray of some kind, and then paint random 

strokes over it using a textured brush of some description. On a separate 

layer I then begin by blocking in the character in rough, bold strokes, 

focusing on the main volumes and areas of color (Fig.04). 

I have used a custom brush to add the textured effect, which was modified 

from a photo of broken glass, of all things (see inset). Much of the other 

blocking in is done using the standard Hard Round Airbrushes and Chalk 

brushes that Photoshop provides.

I always keep the background as a separate layer as it makes it easy to 

change the color scheme and lighting, as we will see later in this tutorial. 
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In fact, I think it would be interesting to have 

the bottom of the image a touch darker and 

have the character almost emerge out of this 

darkness. To do this, I select a gray/green color 

(Fig.05 – see inset) and on a new layer I add a 

Gradient (Foreground to Transparent), and then 

set the layer blending mode to Multiply.

You can also see that I have now started to 

block in the main shadow areas across the face 

and torso, and have better defined the head.

The character at this point appears to be looking 

slightly to his left, whilst the thumbnail sketch 

confronts the viewer directly. So I change this 

here, as well as tidy up the hair shape which 

looks a little windswept (Fig.06). The other 

issue was that his robe was open very low on 

his torso, which was looking a little risqué, so I 

amended this and started to paint in some fabric 

folds. 

So far the Photoshop file has been divided 

into three layers: the background, the gradient 

and the character himself. Continuing on the 

character layer I start to use a grayscale palette 

to work on the skin. This is so I can focus on 

the tonal range, but I also want him to have 

very pale and lifeless flesh to create a ghostly, 

non-human appearance and a suggestion of the 

undead (Fig.07). Although pure coincidence, I 

really like the expression in the thumbnail (see 

inset). It suggests to me a look of sorrow, or 

some forlorn hope which I really want to capture.

Part of the reason I’ve painted the skin in black 

and white is that I can overlay a color, retaining 

the tonal values but with the option of making 

hue changes at any point during the process. 

In Fig.08 you can see a dull ochre color on the 

left, set to Normal mode, but when changed to 

Overlay (see right inset) it adds a certain glow, 

whilst maintaining the ghostly quality.

In compliance with the bottom-left thumbnail 

in Fig.03, I’ve added the character’s left arm 

(Fig.09). You can also see at this point the layer 

structure on the right-hand side palette, with the 

separate color overlay for the skin.

I notice here that the figure looks a little wobbly 

on his feet, so I rotate him slightly to make him 

http://www.2dartistmag.com


page 84www.2dartistmag.com Issue 048 December 2009

Chapter 1: Vampire Painting the Undead
more upright (Fig.10). I also add some fancy 

brocade around the sleeve and torso to add 

some interest, and start to form some of the 

folds in the robe, all of which is done on the 

character layer.

Building the detail
At this point I am starting to realize that because 

I have used my thumbnail as a starting point, 

which was obviously done quickly and not 

accurately, I have transferred many of the 

problems across to my final version; namely the 

proportioning. Not only does the character look 

very tall, but the rib cage looks too low down, 

and his left arm is also too long. Sometimes 

having these exaggerations can help a design, 

and in this case the small head and long arm 

does somehow lend our vampire a creepier 

presence. In fact, a smaller head is often a good 

device to make a character seem more heroic 

and portray a sense of power!

However, I have decided to squash everything 

up a little, which I do using the Edit > Transform 

> Scale tool. I duplicate the right arm, and on a 

new layer move it to a better position, using the 

Eraser Tool to blend it in with the original layer 

before merging the two together. In Fig.11 you 

can see the original position highlighted in red 

and how it has been altered.

With the anatomical proportions improved I start 

to work on some more detailing, namely fixing 

him on the ground. I consider the idea of having 

the robe hide his legs, or making the bottom part 

of the painting dark to create the impression of 

him floating, but I settle on some boots, along 

with a small decorative element to his robe 

(Fig.12). I add another gradient to make the 

bottom part of the painting darker, which also 

emphasizes his skin color.

I’ve been moving the robe detail around but 

it never really seems to work until I place it at 

the top of his left boot, which immediately feels 

right. I’ve also added another small focal point to 

the bottom section of the picture.
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One other part of the design which has been 

causing me some problems is the hands, which 

look rather too symmetrical – as though he 

is sitting on a throne. I’ve thought about the 

nature of vampires and their reputation of being 

able to charm and seduce their victims, and so 

I’ve decided to change his left hand to a more 

beckoning gesture (Fig.13).

It’s always good to have a distinct lack of 

symmetry in your characters to make them more 

believable, but in Fig.14 you can see that the 

naval is far from being central to the torso and 

head, and looks awkward as a result.

Refining
I alter the shape of the hair, making it less 

bouffant, and I add some length and highlights 

on a different layer, just in case I want to 

reverse it or leave it short (Fig.15). You can also 

see that I have created a new layer called “eye 

color”, which is set to Overlay and shows the 

red tint around the eyes.

You will have noticed that the background color 

has changed throughout this tutorial, which 

is the advantage of keeping it separate to the 

character. You may wish to change the tonal 

values etc. – or in this instance add some 

textural detail in the form of a blood spatter 

(Fig.16). I created this custom brush a while ago 

and thought, with some subtle use, could prove 

appropriate to this particular painting. I added a 

new layer for this effect.

The painting is almost complete now, but after 

having altered the right arm and hand it has 

since seemed inconsistent with the other one. 

The thin wrist and angle of the forearm does not 

feel right and again mimics the thumbnail too 

closely. After using a mirror and some careful 

posing, I decide on a different gesture, the result 

of which can be seen in Fig.17.

Conclusion
This has been a fun project as I have never 

painted a vampire before and more particularly 

because I did not have a clear idea about how 

he would look before starting out.

It’s interesting to see how an idea or feeling 

evolves during the painting process, and you will 

have noticed how the character has transformed 

during this tutorial. There are aspects which 

perhaps do not follow strict rules, such as 

how the robe fits around the body (I am sure 

some fashion experts could point out some 

of the problems to me!), but from an artistic 

perspective I like the flow and rhythm it has 

created.

The boot design and hand gestures have 

certainly been improvised along the way, and 

the fact that one sleeve is torn and ragged 

compared to the other was also unintentional. 

However, part of the fascination with anything 

creative is the fact that it can suggest its own 

direction and surprise you on the way!
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Here is the final version (Fig.18).

Richard Tilbury
For more from this artist visit

http://www.richardtilburyart.com/

or contact

rich@3dtotal.com
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Intro Text

“Quote From Arti-
cle”

Chapter 1 – July
Introducing Photoshop’s Workspace, Graphics Tablets, Screen 

Calibration, Color Profiles and the Brush Tool

Chapter 2 – August 
Canvas Settings, Scanning Drawings, Swatches, Colour Pickers,  

Colour Theory, Layers and Custom Brushes!  
 

Chapter 3 – September
Composition Rules, Sketching and Perspective, Understanding 

Light and Blocking-In. 
 

Chapter 4 – October
Colouring from Greyscale, Colours beyond Blocking-In, Blending  

Methods and Using Photos 
 

Chapter 5 – November
Quick Masks, Using the Wand Tool, Liquify Filter uses, Layer  

Masks – and Painting! 
 

Chapter 6 – December
The Final Part: Finishing Touches, Filters, the Unsharpen Mask 

and Saving your Work
With the series coming to an end in this chapter, we will be looking 

at bringing our work to a close as well, by adding some finishing 
touches with the help of some more filters such as the Blur filters 

and the Unsharpen Mask, changing colours if we’re not quite happy 
with them, and finally saving images in different formats, as well as 

for the internet.

This Workshop Series will look at, just as the title suggests, all the things that we need to know to get us started with 

Photoshop – mainly for painting, but also for other things such as matte painting and photo manipulation, which often 

use the same tools. We will be covering all the technical aspects of the programme, as well as some technical sides 

of painting that’ll help us starting to swing the virtual brush!

“What marks the end for my work, 
putting all this information 

together in one colorful 
package, should only be the 

beginning of your journey 
making use of it.”
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Chapter 6 - The 
Final Part: Finishing 
Touches, Filters, the 
Unsharpen Mask and 
Saving your Work
Software Used: Photoshop

Introduction
As we are now drawing this six-part tutorial 

series to a close, we will be adding the final 

touches to our piece in this final installment. I’m 

almost sad to see the end of it, as I’ve rather 

enjoyed digging through Photoshop and all its 

quirks and treasure troves, and making it a little 

more accessible to those who thought “PS” 

stood for “Post Script” …

We’ll be looking at adding additional lighting and 

overall textures, how to achieve different kinds 

of blurs to indicate motion or a focal blur, how to 

adjust or even change the overall color palette 

and intensity, and saving the picture for different 

purposes, like for print or the internet. All in all, 

this will be a rather short chapter, but no less 

important than the previous ones.

Happily ever after
Every painting is an adventure, akin to good 

old fairytales, so what’s better than to end one 

on a good note? We’ve journeyed from sketchy 

beginnings to massive changes, battling with 

tools and forging alliances with filters to refining 

the elements, and now all that is left to do is to 

tweak those things that will give the painting that 

extra special kick! 

So let’s have a look what we’ve got so far 

(Fig.01): a painting that looks pretty finished. 

However, not having looked at it for some time, 

I can notice some flaws in mine that I wish to 

iron out before attacking the final steps. It really 

is good sometimes to put a painting aside for a 

few days, or even weeks. Seeing it with fresh 

eyes makes you more aware of your mistakes. 

In this case, I notice that the values are a bit 

confusing, namely with the arch against the cliff 

face backdrop. 

Switching the image to grayscale (Duplicate 

image, Flatten, and then Desaturate) shows 

more clearly where the values are off (Fig.02), 

and we should address that. Just lightening the 

parts of the cliff face a little does the trick, using 

the Brush Tool and picking color off the rocks. 

We will do the same with the arch, darkening 

it slightly in those places (Fig.02a). If we now 

check the values in grayscale again, we see it’s 

less muddled (Fig.02b). There are still some 

parts that can use a value boost, but we will look 

at that in a minute, or else we‘ll end up over- 

and re-painting the whole picture.

Something that the painting is distinctly lacking 

is light. Sure, there are light and shadowed 
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areas, but no actual, visible light – it’s all very 

murky right now. We determined a few chapters 

ago where the light source is and painted the 

shadows accordingly. So now let’s actually add 

that light. 

Instead of painting a sun, we will be painting 

the glow of the sun that has to be somewhere 

towards the top right of the image, clearly 

illuminating the left rock faces and the girl on the 

arch. As there are no harsh shadows though, 

there cannot be direct sunlight, but rather an 

indirect haze filtering through the clouds, strong 

enough to cast distinct shadows.

One of the ways to go about doing that is to 

add a new layer right on top of everything, and 

set it to Soft Light or Overlay. Picking a nice, 

bright yellow (Fig.03) and choosing a very Soft 

Round Brush with Opacity set to Pen Pressure 

and Size Jitter switched off, we gently paint over 

the areas that we want to have a glow (Fig.04 

– 04a). Changing the hue slightly here and 

there works nicely to give the light some color 

variation, even if it isn’t all that noticeable, and 

adjusting the Opacity of the layer also helps.

Once again, more and stronger light can and will 

be added later. I’ve found that once an image 

is finalized and all adjustments made, it can be 

beneficial to repeat this step to get much more 

vivid and visible results.

So what’s next?
Blurring

Looking at the scene, we have to assume that 

a wind is blowing, seeing that the dress tendrils 

are happily floating and curling in the air. This is 

all well and good, but maybe we should make 

this slightly more believable?

What happens when you take a photo of a 

fast moving object in low light 

conditions? – Exactly! You get a 

blur. This is often very undesirable 

for photos, but very useful for 

paintings as it lends them a touch of 

heightened realism. There are several ways of 

going about adding blurs, but for a Motion Blur 

the filter of the same name works wonderfully, if 

used with care.

The tendril that we want to add some motion 

blur to would be mainly the central one, floating 

off into the distance. The first thing we need to 

do, before doing anything else, is merge the 

brocade pattern layer with the dress layer, if we 

haven’t done so already. Sometimes, this is not 
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and gives you a nice “clearly visible but moving” 

effect. A similar effect can be achieved by just 

using one layer, blurring it, and then going to 

Edit > Fade, to reduce the blur as much or as 

little as is desirable.

We then go to Filter > Blur > Motion Blur. A 

little box will pop up (Fig.05a). If Preview isn’t 

ticked, tick it, because it will give you a real-time 

preview of the blur on the painting as you adjust 

it in the filter settings. If you cannot see anything 

in the small window but gray and white squares, 

drag its contents around until you see your 

layer. The Angle should be adjusted according 

to the direction of movement – we can do this by 

just turning the little wheel. And the slider at the 

bottom gives us control over the intensity of the 

blur. When we are happy with our selections, we 

hit OK.

Note: Sometimes it works out best if the layer 

that is to be blurred is duplicated prior to 

blurring, and only the duplicate is blurred, while 

the original remains clear. Adjusting the Opacity 

of both layers in that case can be beneficial, 

possible for various reasons; if that is the case, 

the steps I’m about to explain will have to be 

repeated for the pattern layer. If that isn’t done, 

we’d end up with a moving piece of fabric 

but a very static pattern!

We select the Lasso Tool and set its 

Feathering to something quite high; the 

reason being that if we don’t, we’ll get a definite 

break in the fabric where it goes from static to 

blurred, and that’s not very pretty. Instead of the 

Lasso Tool, we can also use the Quick Mask 

with a very Soft Round Brush. It’s all down to 

preference. In this case it’s all very easy, as the 

tendrils that go over the arch are on a different 

layer than the one we need to blur, which means 

no painstaking selection process – we just 

select a nice and wide area around the tendril in 

question (Fig.05). 
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We repeat this process with the other tendrils, 

as needed (Fig.05b).

Another blur filter that can come in useful 

sometimes – and again, if used with great 

care – is Gaussian Blur. It is not so good for 

indicating motion blur, as it simply diffuses 

whatever it is that’s being blurred, rather 

than giving it a directional blur. It can be 

useful for focal blurring – like blurring 

parts of a person that are not meant to be 

in focus (especially long flowing hair and 

out of focus body parts), or the horizon line 

of landscapes. The latter, however, I have 

found to be too much most of the time, but 

that is personal preference so it doesn’t mean 

you shouldn’t be using it for that. The filter 

works the same way as Motion Blur, which 

means there is nothing much to explain or 

show. You can find Gaussian Blur in Filter 

> Blur > Gaussian Blur. Try it and 

see for yourself what effects can be 

achieved with it.

There is a set of other blur filters 

still, which I personally never use. 

Again, this doesn’t mean you can’t 

or shouldn’t. Play around with them 

as see what the different blur filters 

do, and whether you like them or not. 

However, solely relying on filters to blur 

things for you is a bit of a copout in the grand 

scheme of things, so learning how to actually 

paint blurs is very useful.

Of course, there is also the Blur Tool (Fig.06 

- See the icon on the left      ), and used with 

the default Round (and Soft!) Brush it can be 

extremely useful for targeted blurring. I’ve found 

it to be very useful for making objects appear 

more part of a scene by blurring the object’s 

edges ever so slightly. Again, not everything in 

a painting needs that treatment, as sometimes 

sharp edges is exactly what you want or need. 

Again, use it with care. Over-blurring something 

is not very nice!

With this now covered, we are ready to look at 

final adjustments.

Final Adjustments

Often, we realize after finishing a painting 

that maybe the contrast is not quite what we’d 

envisioned, or the colors aren’t quite the way 

we wanted them. There’s no need getting 

panicky or sad over that, as these things can be 

changed.

Before doing anything, let’s just save the 

painting as it is, then duplicate the image (Image 

> Duplicate). This way we still have the original 

version should we decide our tweaking didn’t do 

much good and we want to start again without 

having to fully start over.

Note: Depending on what you want to do 

– whether it’s adjust the overall contrast or 

colors, or just area or level specific things 

– you may or may not want to flatten the 

image. This is another reason why it’s 

good to keep the original layered version 

somewhere safe, in case you aren’t happy 

with it once it’s been flattened, adjusted and 

saved. I’ve learned that the hard way, so this 

may just save you repeating my mistakes!

Before I flatten mine, I want to slightly adjust 

the Levels of the girl, as I feel she’s a little too 

flat in contrast. As I’ve described the basic use 

of Levels in a previous chapter, I won’t repeat it 

now (though I will go back to them in a second 

for some more interesting tweaking). In this 

case, I simply want to boost the basic Levels, 

using the sliders (Fig.07). Once that’s done, I 

take a leap of faith and flatten the image (Layer 

> Flatten). Before doing this, checking that 

everything is in its right place, and there are no 

bits of texture sticking out anywhere where it 

shouldn’t be, is vital! Trying to fix those things 

after an image has been flattened is definitely a 

lot harder, and also more time consuming.
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The first thing I tend to do once I am at this 

stage is to see if changing the Levels will do 

any good to the painting. So let’s have a closer 

look at some more options with this little tool 

(Fig.08).

Using the normal sliders often already gives us 

enough to play with. But there is more. In the 

Channel dropdown menu, we can choose to 

either change the Levels for RGB (Red, Green, 

and Blue) altogether or select one channel at a 

time and adjust it to our liking (Fig.08). And that 

isn’t all. If you look at the buttons on the right, 

there is one called Options; if you click that, you 

get another box (Fig.09a – b).

Let’s go through the settings one by one – 

they sound complex, but are really easy to 

understand.

Algorithms:

Enhance Monochromatic Contrast – Auto 

Contrast Option: It adjusts all channels/colors 

identically, preserving the overall colors of the 

picture but enhancing the darks and lights 

(Fig.10a).

Enhance Per Channel Contrast - Auto Levels 

Option: This maximizes the tonal range in each 

channel separately, changing the colors quite 

drastically (Fig.10b).

Find Dark & Light Colors - Auto Colors Option: 

This one finds the lightest and darkest pixels 

in the image and uses them to up the contrast 

(Fig.10c).

Snap Neutral Midtones: Tick this is you want 

Photoshop to find a nearly neutral color in 

the image and adjust the midtone values 

accordingly.

Target Colors  Clipping:

Clicking on the color swatches next to Shadows, 

Midtones and Highlights lets you change 

the colors of your Shadows, Midtones and 

Highlights. This is quite fun to do.
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Clip: These specify how much of the darkest 

(shadows) and lightest (highlights) Photoshop 

should ignore when identifying for the darkest 

and lightest pixels in an image. This is done 

so the highlights and shadows, when auto 

corrected, won’t be too extreme.

And that’s that! Once you click OK, the Levels 

can still be played with, as usual. There are – as 

always – no rules as to what goes and what 

doesn’t; it’s all down to personal taste.

Variations

With the Levels adjusted (Fig.11), I always 

like to see if perhaps the Variations can be 

played with. You can find those under Image > 

Adjustments > Variations (Fig.12). I’ve found 

them to be a brilliant way to adjust, or even 

totally change, a painting’s overall colors. They 

are really quite self-explanatory as well; we can 

choose to adjust the Highlights, Midtones or 

Shadows, both in color as well as in lightness 

or darkness, and the slider gives us the option 

to have a drastic (coarse) change, or a subtle 

(fine) one. We can also change the Saturation of 

a picture. I’m personally rather fond of the bluish 

tint displayed in the bottom left corner, and so 

I play with adjusting that until it works for me 

(Fig.12a). The warm yellows and browns are 

lovely to look at, but don’t quite match the mood 

I have in mind after all.

Selective Color

There are many more ways to adjust and 

change the colors in a finished piece. A very 

useful option is the Selective Color setting – 

Image > Adjustments > Selective Color – which 

lets you adjust colors with targeted precision 

(Fig.13). With the dropdown menu you can 

choose the color that you want to adjust, and 

with the sliders you adjust it. The Relative 

and Absolute options give you either a 

more subtle result, or something more … 

absolute. Play with it – great fun!

Curves

There are also the Curves which can help adjust 

the color and tonal value of a picture. We get 

the Curves by going to Image > Adjustments > 

Curves (Fig.14). At first this box may look a bit 

confusing, but giving it a closer look it has many 

similarities with the Levels Adjustment box. The 

dropdown menu at the top gives us the choice 

between RGB, Red, Green and Blue. This 
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means we can adjust either all channels at once 

or each channel separately. If we are working 

in CMYK, it will of course give us the CMYK 

options. 

The three eyedroppers at the bottom right are 

once again there to set the White Point, Gray 

Point (Midtones), and Black Point, if we wish. 

And then there is the diagonal line in the box. 

This line is what we want to play with. The top 

end of the line is our Highlights, the bottom one 

the Shadows, and the point right in the center is 

our Midtones. By moving the line or (imaginary) 

points on the line, we can change the color and/

or values of an image. Try it! Often, just a minor 

adjustment of the curves is needed to get the 

desired results.

The two buttons               beneath the curves 

adjustment box let you adjust the curves by 

adding points, or draw your own curve. By 

default, the first button is clicked, and all we 

need to do to add points on the curve is click on 

the curvy line! Very easy!

What else?
Color Balance

Color Balance is a nice little tool that – just like 

Variations – lets you adjust the colors of an 

image. It’s one of the easiest tools to use, and 

to great effect. You can find it under Image > 

Adjustments > Color Balance (Fig.15). We can 

choose to adjust the Shadows, Midtones 

or Highlights, and using the sliders 

we do exactly that. Moving the sliders 

more to one color or the other changes 

the color more towards the one we slide the 

slider to. Simple! Un-ticking Preserve Luminosity 

pretty much dulls down the colors of the image, 

and it‘s not always desirable.

Hue/Saturation

And then there is Hue/Saturation, which can 

also be found in Image > Adjustments > Hue/

Saturation (Fig.16). This one is a little bit more 

complex, but once you get the hang of it, it’s 

quite easy to use – just like everything else! 

What you need to bear in mind with this one is 

that no amount of screenshots can show you 

exactly how it works; you have to play with it 

yourself to see what it can do.

Keeping the Master setting from the dropdown, 

all we can do is change the Hue (Color), 

Saturation (intensity of Color) and Lightness 

(Shade) of the entire picture. Once we choose 

a color from the dropdown menu, we are 

presented with an entire new set of options to 

play with (Fig.16a). The top sliders keep their 

purpose, and do exactly what it says on the box. 

We can completely ignore the bottom sliders 

that are showing now if we wish to. However, 

those bottom sliders are quite neat, as we can 

adjust the range of the color we want to adjust 

and also slide through the entire spectrum, 

saving us having to use the drop down menu. 

Playtime!

Note: For more options and explanations 

regarding any of these tools, or in fact anything 

PS has on offer, you may want to check out the 

Help (shortcut: F1) that PS provides!

At this point we are essentially finished, but we 

can once again look at the lighting in our piece. 

With all the adjusting, the glow we had before 

may have gone, and the piece may have lost 

its sense of depth. To fix that, we do what we 

did before: We add a new layer, and choosing a 

light color (in this case blue as it won’t enhance 

the yellow, but will balance it out) we paint the 

light in targeted areas – namely to peel the arch 

off the cliff face and give the horizon and distant 

cliffs an out-of-focus haze (Fig.17). We then set 

the light later to Pin Light and see if it works by 

adjusting the Opacity sufficiently.

If Pin Light doesn’t work at all, Soft Light will do 

the trick. Using Overlay in this case would just 
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make the colors much more intense, rather than 

softening them up a little. I also added some 

dark brown on the ground near the horizon to 

indicate some not-quite-so-strong shadows 

from the cliffs on the right. The image can be 

flattened once everything is as we’d like it to be 

(Fig.17a).

At this point, I suddenly realize that I am 

absolutely not happy with the dimensions of the 

canvas – it would look much better if it were a 

little wider still, to give the whole scene a slightly 

more panoramic effect. All good and well … can 

be done! The only thing is that I have to go back 

to the layered version of the image for this, and 

with that lose all the work we’ve done to the 

image since flattening it ... Why? Because to 

extend the canvas to one side (the right in this 

case), without having to repaint that part or add 

painted bits to it, we need to be able to select 

the background with the Marquee Tool from 

the gap between the cliff faces in the distance 

to the far right edge of the original canvas 

after changing the canvas size, and then 

Transform it, pulling it to the right to cover the 

entire canvas again. 

After repeating everything from adding 

ambient light to adjusting the Levels and 

Variations, the image looks slightly different 

than before. Instead of going with the previously 

adjusted colder palette, I‘ve decided to keep 

the warmer green and yellow hue (Fig.17b). 

Lesson learnt here: Leave a painting alone 

for a couple of days before rushing into any 

finalizing bits and bobs. It can save the extra 

work of doing it all over again!

Right, if we want to, we could now add 

some overall texture to the image. This 

usually works best when there is either 

no texture at all in a piece, or they are 

very subtle brushed textures. When you 

already have a load of textures, like in this 

case, an overall texture may make the image 

look far too busy. However, I will still briefly go 

through the options:

Both photos and brushes can be used again for 

applying an overall texture. Photos should be a 

high resolution so pixelization will be kept to 

a minimum when the photo is transformed 

on the canvas to match the size of the 

canvas. You can use virtually any photo 

texture for this – from rusty metal and 

watercolor stains, to paper or canvas 

textures. The color in the photos may even 

lend an interesting effect to a painting, so the 

photos don’t have to be in grayscale. Overlay 

and Soft Light are both options that that work 

really well for a texture layer.

Of course, we can also make a brush from a 

texture photo and stamp it onto a new layer 

onto the canvas, and then transform it to 

match the canvas size. Here we have some 

more options of locking transparent pixels and 

painting over the texture in different colors to 

get the desired effect, as well as lowering the 

Opacity, as before. Naturally, a texture can also 

be achieved by painting random brushstrokes 

onto a new layer, preferably with rough brushes 

like the speckled one. The possibilities are 

endless!
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I won’t apply a texture to my painting, as it has 

the right amount of textures already in it. More 

would simply overdo it.

Okay, that’s it! We are done! We can save 

the image, grab a coffee and sit there for five 

minutes in quiet admiration of our handiwork 

… or something along those lines. Of course, 

most of us are deep down quite narcissistic little 

critters who want nothing more than to show off 

what we’ve just managed to do. And don’t give 

me, “No, I’m not!” – You’d not be human if that 

was the case! Anyhow, I digress…

Showcasing your 
handiwork
Now, there are several ways to showcase your 

work. The first option would be the standard fine 

art approach of exhibiting in a gallery. For this, 

the work would have to be printed. Saving it for 

this purpose is really quite simple. We need to 

bear in mind that the bigger the file, the bigger 

the print can be done at a high quality. 

But we also need to look at the file format in 

which to save our picture, as there are lossless 

and lossy formats. What that means is this: A 

lossless file format is a format that does not 

compress the pixels, but keeps everything as 

it is. Common lossless formats are PSD, PNG, 

and TIFF. Lossy formats on the other hand 

compress the pixels – meaning they reduce the 

general information stored in the painting to the 

effect that it will be smaller in file size, but also 

at not quite so high a quality, dumping pixels 

that it won‘t really need. This format is great for 

internet use as it loads fast and still looks very 

decent on any screen. JPG and GIF are lossy 

file formats (and GIF should be avoided unless 

you do pixel art, as a GIF only ever has 256 

colors).

So, we now know that we should save our 

image as a PSD, PNG or TIFF to get a great 

print from it – this is especially the case when 

you know that your piece will be printed with 

the same methods as a fine art piece, or in 

magazines and books.

We go to File > Save As… and get our Save 

As window (Fig.18). We can give the image a 

name in the File name bar, and then choose 

our format in the Format dropdown menu. In the 

Save Options, we also get the choice to Save 

As a Copy, and in the Color Options we can 

decide if we want to keep the color profile we 

assigned to our picture, or not (Fig.18a). Most of 

the options only become available when saving 

something in a specific format, so don’t worry if 

there isn’t much you can tick or un-tick.

Once we hit Save we will get another box giving 

us more options – different options depending 

on the file format we are saving in. The default 

settings are the ones we want for saving an 

image for print, so we leave things as they are 

and hit OK.

Some of you may wonder why I’m not going into 

detail about all the options. Believe me, if I did 

it would be another chapter all unto itself! So I 

suggest you consult Adobe’s online Help manual 

for a more detailed breakdown.

Note: The default PSD file format PS uses when 

saving layered images is great, but unless a 

print place uses Photoshop or a similar program 

there may be difficulties in opening the file for 

print. So saving as a TIFF or PNG is usually the 

safer option. If unsure, ask at the place where 

you want to have the picture printed, or consult 

an online print studio’s FAQ for help!

We can use the same option of Save As to save 

the image as a JPG or GIF. Once we hit Save, 

upon selecting this file format we are presented 

with another box and more options, just like with 

the file formats before. This way of saving an 

image as a JPG is good for saving it for print or 

other large format displays, but not so much for 

use on the internet, as the compression is not 

ideal and the quality pretty shoddy. Don’t ask me 

why, I really don’t know.

So what can be done to save an image for use 

online?

First things first: we need to resize the image. 

Most people have screens no bigger than 

17” – even though in the CG art scene, most 

professionals boast screens up to 30”, or 

multiple screen displays. However, the majority 

of people who are browsing the web are not CG 

artists, and it is those people we need to keep in 

mind. Therefore, it is pretty pointless to display 

an image at its original size online. For starters, 

it wouldn’t be possible to view the entire image 

without scrolling, and thus the impact the image 

could have if viewed in full is lost. 

So for our image to not suffer this fate, we need 

to resize it to something reasonable – anything 

between 800 and 1600 pixels at the longest 

side. More would become too big. Usually, 

something around 1000 pixels at either side is 

a good size (and then we can show some small 

excerpts of a bigger resolution, close-ups, if you 

wish, so people can get an idea of what it looks 

like in more detail, and see all the little details).

We may want to duplicate the image before we 

continue, so we can be sure that we won’t be 
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screwing things up and accidentally overwrite 

the original file at any point in time.

We go to Image > Image Size (Fig.19). 

To change the image size for web use, all 

we need to do is change the size in pixels, 

leaving everything else alone. When we’re 

done, we hit OK.

Changing the image size to something 

significantly smaller always has the effect 

of “blurring” the image. This is because the 

information previously stored in a much 

higher amount of pixels has now been 

condensed to something a lot lower. To bring 

some sharpness back into the image we can 

use the Unsharp Mask. We can find it under 

Filter > Sharpen > Unsharp Mask (Fig.20). 

The default settings of this Filter actually 

give a pretty good result, but that should not 

stop you from playing around. Keeping the 

default settings for my painting, the difference 

is quite obvious between before applying the 

Unsharp Mask (Fig.20a) and after applying it 

(Fig.20b).

Sometimes, the Unsharp Mask makes certain 

parts too sharp, and those can be adjusted 

manually by using the Blur Tool (carefully!). Of 

course, the complete Unsharp Mask can be 

faded by going to Edit > Fade.

Now we are ready to save the image for internet 

use! We go to File > Save for Web… and a 

new window comes up (Fig.21). It will show 

us our image in the Optimized tab window. To 

check what the original looks like, simply click 

on the Original tab at the top, and it will change. 

The settings you see in the screenshot are my 

default settings for saving something for the 

web. The Quality can be changed by either 

entering a number manually, or by clicking on 

the arrow and using the slider that pops up. The 

dropdown menu that says JPEG also offers 

GIF, PNG-8 (like GIF uses only 256 colors 

maximum), PNG-24 and WBMP (which is a 

black and white grain thing reminiscent of the 

first computer images ever made).

The Preset dropdown gives you a list 

of preset options, so you won’t have to 

set and adjust them all yourself. Ticking 
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the ICC profile is good, as this keeps your 

image’s Color Profile intact. And if you click 

on the Image Size tab next to the Color Table 

tab below the settings, you can even change 

the size of the image again. However, I found 

that changing it before saving this way gives you 

better results.

Once all settings are adjusted to our liking, we 

hit Save. A “Save Optimized As” window pops 

up, asking us to enter a file name, which we 

should do. It also asks us our Save as type 

preference – here the default setting is Image 

Only (*jpg), which we should keep. The other 

settings are for website layouts and HTML code. 

We hit Save again, and our image will be saved, 

optimised for web use.

And now we can show what we’ve done to 

anyone who wishes to see it…

In Closing
What marks the end for my work, putting all this 

information together in one colorful package, 

should only be the beginning of your journey 

making use of it. Enjoy it, live it, create!

Nykolai, signing off!

Nykolai Aleksander
For more from this artist visit

http://www.admemento.com/

or contact

x@admemento.com
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Branko Bistrovic is with us this month to take us 

behind the scenes and straight into the creation 

process of his recent piece, “The Breath on Your 

Neck”. Inspired by a blind man in the streets, and the 

good old Maple Leaves Photoshop brush, Branko 

set about this stunning image and took it through a 

whole range of flips and adjustments before happily 

calling it a day. As he says, “it was all cheddar cheese 

easy!”, so immerse yourself in another fantastic 

making of in 2DArtist, and don’t forget to download 

the complimentary custom brush on offer from Branko 

himself. Enjoy!

“You can never really be 
sure where you’ll get your 

inspiration, but when it does 
come, hold onto it like a 

lifeline!”

• Free Custom Brushes

http://www.2dartistmag.com/tutorial_resources/issue_048_dec_2009/makingof/makingof01_custombrush.zip
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The Breath On Your Neck Making Of Sub Heading

• Spacing – 46

• Size Jitter and Angle Jitter – 100  

• Roundness Jitter at 40

• Minimum Roundness – 50 (make sure the 

Roundness Jitter isn’t too great; we don’t 

want our maple leaves to look like they’ve 

been steamrolled!)

• Opacity Jitter – 20 (also turn on Pen 

Pressure for Opacity – this is the only setting 

that I use to recognize Pen Pressure in this 

setup; the rest of them are all on random 

jitter)

• Finally, set that Flow Jitter to a more 

aggressive 40

Then it was all about making some marks on the 

canvas! I first of all filled the canvas with a dark 

blue, since I was going to make my character 

an orangey hue. Utilizing color complementaries 

will help make your piece pop, and as long as 

it’s done subtly it won’t come off as tacky or 

crass (Fig.01). 

I very quickly established the general lighting 

and texture for the background; I also started 

to bring in varying greens and oranges on 

top of the blue (all on the same background 

layer) (Fig.02) – keeping things rather subtle, 

spending little time on it, and letting it all flow 

freely.

On a new layer I started to pose the character 

and the lighting. He was looking like Mr. Smoke 

here – interesting, but not what I wanted 

(Fig.03). At this stage I was thinking: What the 

The Breath On Your Neck
Software Used: Photoshop

I don’t know about you, but when I begin 

a painting there are usually two ways the 

idea arrives in my noggin: either it’s a happy 

discovery  while making random marks on the 

canvas, or it’s something that came to me while 

I was out and about living in “the real world”. 

Like how at the movies watching a comedy I get 

the idea to paint flowers and robots, or while 

I’m in the shower scrubbing shampoo off my 

head I envision a captive mermaid screaming at 

heaven … You can never really be sure where 

you’ll get your inspiration, but when it does 

come, hold onto it like a lifeline! It can be the 

fuel to your flame on those days when picking 

up the pencil seems like a journey. 

In the case of this piece, I initially really didn’t 

know where I was going until I passed by a 

blind man on the street who seemed perfectly 

capable of his surroundings. The moment 

granted me a solid visual to my idea. After that it 

was all cheddar cheese easy … Well, not quite, 

but at least I felt a little more confident with 

where I was heading!

I began this piece mundanely enough by using 

the default scattered Maple Leaves brush, with 

settings of:

“The moment granted me a 
solid visual to my idea.”

http://www.2dartistmag.com
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Making Of The Breath On Your Neck
hell am I going for here? Is it a guy looking at 

something in his hand? Is this a confused ape? 

Or a bald ferret the size of a man?! So I decided 

to take a walk, clear my head, and that’s when 

I came across the blind man in the street and 

– pop! – things fell into place enough for me to 

head back to the canvas.

Here I started solidifying; better defining where 

the lighting was coming from – the top-right 

corner in this case, with a slight bluish accent on 

his back (Fig.04).

For now, the focus is on subtracting and adding 

to the shape of the character, keeping the 

flow in the gesture while not making it overly 

exaggerated and cartoony; I want to keep this 

piece somber. To me, lighting, gesture and 

silhouette are the aspects I must focus on 

and struggle with in a painting. I feel that if the 

lighting is convincing you can make anything 

come to life! If the gesture is convincing, any 

shape can be interesting, and if the silhouette 

captures your imagination then the piece will be 

remembered long after.

At this point I noticed that whatever he had in 

his hand was starting to look a lot like a potential 

infant skull, which I thought was gross, but 

intriguing … (Fig.05) And then I decided to 

make it a bestial skull instead (yeah, I chickened 

out!). 

I continued nailing down the shapes. It’s easy 

to get carried away, especially when you are 

300% zoomed in and think, “Ooh that eye looks 

“…lighting, gesture and 
silhouette are the aspects I 
must focus on and struggle 

with…”

http://www.2dartistmag.com
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so nice”, or, “Those lips – how plump!” But then 

you zoom out only to realize everything has a 

separate light source. So stay broad and not 

pinned down!

The canvas was flipped to get a fresh 

perspective (Fig.06). 

I then added a little character holding onto 

the skull, since I felt the piece was lacking 

something like this. I could then start deciding 

on the details and where to place them; like 

the tattoos on his face, or the way his ear is 

shaped, and what’s dangling out of his hair. 

This is usually where the painting comes to a 

crawl, and also where the painting enters its 

ugly stage, so I just had to accept that for the 

next little while, I wasn’t going to like what I was 

seeing and kept reminding myself of the overall 

vision at the end, which (I prayed) would be 

more pleasant (Fig.07).

Continuing to refine, I was pretty much ready to 

start adding textures to the skin, and blending 

the transitions. The brush – which I am giving 

away for free with this article, simply click on the 

Free Resources logo to download it – was just 

a simple speckled brush. I applied it first using 

darks, then I subtracted from it with lights; this 

way it melded and blended into itself (Fig.08). 

This process required some patience, so I 

always advise some music or an audio book 

handy at this stage!

Okay, so it took about twice as long to get from 

Fig.07 to 08 as it did to get from Fig.01 to 07, 

but I was finally starting to like what I saw here, 

and could at last stop squinting so much! I 

shifted things around slightly, lightened aspects, 

trying my best to balance the lighting and allow 

for a realistic sense of fantasy. I also flipped it 

again – I like it more facing this way (Fig.09). 

Just a gut thing!

I pumped up the contrast by pushing the blacks 

and lightening the focal points. I also saturated 

the areas that weren’t in direct light or totally 

veiled in shadow by creating a layer above the 

whole piece, setting the layer blending to mode 

to Overlay and painting in the colors I wanted. 

And there we have it: the final piece (or as close 

as it’s ever going to get) (Fig.10).

Truth be told, the process of creation is the most 

enjoyable bit for me; the results in comparison 

are usually pretty anticlimactic. Taking a look 

at this piece for instance: I am pleased with the 

final render but at the same time not too certain 

that this was exactly what I was searching for. 

I feel that, as strong as the lighting is, it could 

have still been better refined and the character’s 

shoulder anatomy could also be revisited. 

Alas, this is usually the case when it comes to 

my work; I can’t help but analyze it every time 

I return to it. While I’m sure this sounds pretty 

frustrating, in the end every artist is their own 

worst critic, and ultimately it’s this mentality that 

demands more from me and challenges my 

expectations, which in turn spurs me to strive 

for better, so the fact doesn’t really annoy me! 

In the end, the gratification of another project 

“…every artist is their own 
worst critic…”

“…I just had to accept that 
for the next little while, I 

wasn’t going to like what I 
was seeing…”

http://www.2dartistmag.com


complete is still there, and that’s a fuzzy feeling 

for sure.

I hope you have enjoyed this article. If you have 

any questions please feel free to get in touch. 

Cheers!

Branko Bistrovic
For more from this artist visit

http://branko.cgsociety.org/gallery/

or contact

bisvic@gmail.com

• Free Custom Brushes

http://branko.cgsociety.org/gallery
mailto:bisvic@gmail.com
http://www.2dartistmag.com/tutorial_resources/issue_048_dec_2009/makingof/makingof01_custombrush.zip
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Introduction: 
The ‘Digital Art Masters: volume 1’ book, is 

a collection of work from artists which 

have featured in the gallery of 3DTotal. 

Spread over 192 pages, the book features 

some of the finest digital 2D and 3D art-

work that you can see today, from artist 

as Natascha Roeoesli, Philip Straub, Rob 

Chang, Jesse Sandifer, PiSONG, Meny Hilsen-

rad and Ryan Lim and many more. More 

than just any other gallery book, each 

artist has written a breakdown overview, 

each with supporting imagery of how they 

made there piece of work.

for more products in our range visit http://www.3dtotal.com/shop

The first book in the “Digital Art Masters” series, 
contains work by the following artists: 

André Holzmeister, Andrey Yamkovoy, Balazs Kiss, Cetin Tuker, Daniele Montel-

la, d’Ettorre Olivier-Thomas, Donald Phan, Drazenka Kimpel, Egil Paulsen, Eric 

Wilkerson, Fabricio Micheli, Francisco Ferriz, Fred Bastide, Fredrik Alfredsson, 

Haure Sebastien, Jesse Sandifer, Jorge Adorni, Juan J. González, Juliano Castro, 

Khalid Abdulla Al-Muharraqi, Landis Fields, Laurent Gaumer, Laurent Ménabé, 

Li Suli, Linda Tso, Marcel Baumann, Marco Siegel, Mariska Vos, Meny, Hilsenrad, 

Natascha Roeoesli, Nicolas Richelet, Niels Sinke, Norbert Fuchs, Olli Sorjonen, 

Omar Sarmiento, Patrick Beaulieu, Philip Straub, PiSONG, Richard Tilbury, Rob 

Adams, Robert Chang, Romain Côte, Ronnie Olsthoorn, Rudolf Herczog, Ryan 

Lim, Siku and Thierry Canon

: volume 1

http://www.3dtotal.com/damv1


With the release of 3DTotal’s latest book, 

Digital Art Masters: Volume 4, we have 

some exclusive chapters for you...

This book is more than just an artwork 

book. Not only does it feature 

full-colour, full-page images, but each artist 

has given a detailed description, in their 

own words, of the creation process behind 

each piece of published artwork. And 

they’ve done it especially for this book! 

This month we feature:

 

“The Beetle 
Lord” 

by Nicholas Miles

http://www.2dartistmag.com
http://www.2dartistmag.com


The following shots of the “The Beetle Lord” book pages are featured here in full-resolution and can be read by zooming in...

Digital Art Masters:   
Volume 1, 2, 3 & 4 

Now avaliable from the 3DTotal shop: http://www.3dtotal.com/books/

(Note: if a security dialogue box appears, tick ‘Remember’, then click ‘Allow’)

http://www.2dartistmag.com
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About us  3DTotal

Is a resource website for the CG community; 

amongst our growing number of products for CG 

artists, we produce two monthly downloadable 

PDF magazines – 2DArtist and 3DCreative. 

We are based in the West Midlands, in the UK, 

and our intention with our magazines is to make 

each issue as full of great articles, images, 

interviews and tutorials as possible. If you 

would like more information on 3DTotal or our 

magazines, or if you have a question for one our 

team, please use the links below.

Contact Information
http://www.3dtotal.com

http://www.3dcreativemag.com

http://www.2dartistmag.com

Editor & Content Manager > Lynette Clee 

lynette@3dtotal.com 

Lead Designer > Chris Perrins 

chrisp@3dtotal.com 

Marketing > Jo Hargreaves

jo@3dtotal.com

Partners
If you have a CG community website and would 

like to support 3DCreative and/or 2DArtist 

magazine by showing our banners, please 

contact Lynette Clee at the email address above

http://www.2dartistmag.com
http://www.3dtotal.com
http://www.3dcreativemag.com
http://www.2dartistmag.com
mailto:lynette@3dtotal.com
mailto:chrisp@3dtotal.com
mailto:jo@3dtotal.com
http://www.epilogue.net/
http://www.cgdirectory.com/
http://www.masteringmentalray.com/
http://news.hiperia3d.com/
http://www.vanishingpoint.biz/
http://www.fallingpixel.com/
http://www.krazybov.com/
http://www.cgpad.org/
http://www.fridgemonsters.com/
http://www.ambiguousarts.com/
http://arttalk.ru/
http://www.inspiring3d.com/
http://www.childplaystudio.com/
http://vainsoftgames.xm.com/
http://www.3dhype.com/
http://www.3dm3.com/
http://www.3drevolution.org/
http://www.veegraph.com/
http://www.cgart.ir/
http://www.cgtantra.com

